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Welcome!

Firstly, we would like to thank you for your choice of Steinberg’s 
Cubase SX/SL! This program represents a new generation in music 
creation and production software tools: more than 15 years experi-
ence with creating the tools musicians want to use and the absolutely 
latest technology are condensed into this all new Cubase SX/SL. 

With Cubase SX/SL’s forerunners Steinberg have proved that there is 
no need for expensive and constantly out-of-date dedicated audio hard-
ware to create a very capable audio workstation: Cubase SX/SL is not 
just equal to such systems, but one that can be better and certainly 
more flexible. Just to prove the point, Cubase SX/SL comes complete 
with VST System Link allowing several computers to be linked together 
and actually perform as one fully integrated system. The idea of a maxi-
mum project size simply doesn’t count anymore. 

As you get acquainted with Cubase SX/SL you will find many more 
advantages. Advanced, automated mixing facilities with support for 
VST 2.0 plug-ins and virtual instruments, and ASIO 2.0 compatible 
audio hardware. Extremely flexible multiple undo & redo, with the pos-
sibility to selectively remove or modify applied audio processing at any 
point in the undo history. Surround sound support and handling that 
makes other systems look like surround sound was an afterthought 
rather than an initial design goal (Cubase SX only).

Cubase SX/SL is not only better than its want-to-be competitors; it's 
distinctly better. The Cubase SX/SL team has already benefited from 
the input they receive from Steinberg users and will continue to do so. 
From this direct communication with the people actually using Cubase 
in their professional working lives or as music enthusiasts, a very clear 
picture emerges about in what direction Cubase SX/SL will develop.

You are invited to join us in helping decide where we go next. Please 
visit the Steinberg web sites and give us your feedback and sugges-
tions.

See you there!

The Steinberg Cubase SX/SL team.
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About the manuals and the Help

The Cubase SX/SL documentation is divided into four sections:

The Getting Started book

The book you are reading now covers the following areas:

• Computer requirements.
• Installation issues.
• Setting up your system for audio, MIDI and/or video work.
• A guided tour of the main Cubase SX/SL windows.
• A quick start for users of previous versions of Cubase.
• An introduction to the most common procedures for recording, playing back, 

mixing and editing in Cubase SX/SL.
• Basic concepts and terminology.
• A description of the general methods used when working in Cubase SX/SL.

In other words, this book does not go into detail on any Cubase SX/SL 
windows, functions or procedures.

The Operation Manual

This pdf document contains the main Cubase SX/SL reference docu-
mentation, with detailed descriptions of Cubase SX/SL operations, pa-
rameters, functions and techniques. You should be familiar with the 
concepts and methods described in the Getting Started book before 
moving on to the Operation Manual. 

• You can open the Operation Manual pdf from the Help menu in the program.
• Under Windows you can also open this document from the Cubase SX/SL 

Documentation subfolder on the Windows Start menu.
• Under Mac OS X the Operation Manual pdf is located in the folder /Library/

Documentation/Cubase SX/ (or /Cubase SL, depending on the program).

Score Layout and Printing (SX only)

This pdf document covers the Score area of Cubase SX. It is opened 
in the same way as the Operation Manual; from the Start menu (Win-
dows), from the /Library/Documentation/Cubase SX/ folder (Mac OS X) or 
from the Help menu in the program.

• There is a more basic Score editor in Cubase SL – this is documented in 
the Operation Manual.
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The Help System

Cubase SX/SL comes with a detailed help system, making it easy to 
look up procedures and descriptions from within the program. The 
contents of the help basically mirror the complete Operation Manual 
text. The help systems are slightly different depending on which oper-
ating system you use, Windows or Mac OS X:

HTML Help (Windows)

You use the HTML Help in the following way:

• To open the HTML Help for browsing, select “HTML Help” from the Help 
menu in the program.
This brings up the HTML Help browser in which you can browse the help table of con-
tents, search the index or perform a free text search.

• To get information about the active window or a dialog, press [F1] on the 
computer keyboard or click the Help button in the actual dialog.
Within a topic, related topics are sometimes directly accessible via clickable links.

Apple Help (Mac OS X)

You use the Apple Help in the following way:

• To open the Apple Help for browsing, select “Cubase SX/SL Help” from the 
Help menu in the program.
This brings up the Apple Help Viewer window. There, you can either browse the help 
table of contents, use the index or type any words into the Search field at the top of the 
window.

• To get information about the active window or a dialog, press [F1] on the 
computer keyboard or click the Help button in the actual dialog.
Within a topic, related topics are sometimes directly accessible via clickable links.

Please note that you can open the Cubase SX/SL Help even when 
the program isn’t running: 

1. Select “Mac Help” from the Help menu in the Finder.

2. In the Apple Help Viewer, bring up the “Help Center”.

3. Click the “Cubase SX/SL Help” link in the Help Center.
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About the Acrobat pdf format

The Operation Manual and Score Layout and Printing documentation 
is provided in the Adobe Acrobat pdf format. An Acrobat installer is 
provided on the program CD.

About the program versions

The documentation covers two program versions; Cubase SX and 
Cubase SL, for two different operating systems or “platforms”; Win-
dows and Mac OS X. 

Some features described in the documentation are only applicable to 
the Cubase SX version. Whenever this is the case this will be clearly 
indicated in the heading of the related subject.

Similarly, some features and settings are specific to one of the plat-
forms, Windows or Mac OS X. This is also clearly stated. 
In other words:

• If nothing else is said, all descriptions and procedures in the documenta-
tion are valid for both Cubase SX and Cubase SL, under Windows and 
Mac OS X.
The screenshots are taken both from the Windows version and the Mac OS X version.

Key command conventions

Many of the default key commands in Cubase SX/SL use modifier keys, 
some of which are different depending on the operating system. For ex-
ample, the default key command for Undo is [Ctrl]-[Z] under Windows 
and [Command]-[Z] under Mac OS X.

When key commands with modifier keys are described in this manual, 
they are shown with the Windows modifier key first, in the following 
form:

[Win modifier key]/[Mac modifier key]-[key]

For example, [Ctrl]/[Command]-[Z] means “press [Ctrl] under Win-
dows or [Command] under Mac OS X, then press [Z]”. 

Similarly, [Alt]/[Option]-[X] means “press [Alt] under Windows or 
[Option] under Mac OS X, then press [Z]”.
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How you can reach us

On the Help menu in Cubase SX/SL, you will find items for getting ad-
ditional information and help:

• On the “Steinberg on the Web” submenu you can find links to various 
Steinberg websites. Selecting one will automatically launch your 
browser application and open the page.
You can find support and compatibility information, answers to frequently asked ques-
tions, links for downloading new drivers, etc. This requires that you have a web browser 
application installed on your computer, and a working Internet connection.



2
Installation and Requirements

for Windows



CUBASE SX/SL
2 – 14 Installation and Requirements for Windows

About this chapter

This chapter describes the system requirements and installation pro-
cedures for Cubase SX/SL for Windows. Installing Cubase SX/SL for 
Mac OS X is described on page 24.

Requirements

To use Cubase SX/SL, you need the following:

• A PC with either Windows XP or Windows 2000 installed.
A USB Port is also required.

For more details about the computer requirements, see below.

• Compatible audio hardware.
By audio hardware we mean a card capable of recording and playing back digital au-
dio using your hard disk as a storage medium. It must also have an appropriate ASIO 
driver, see page 16, or be Windows Multimedia compatible.

For MIDI

• At least one MIDI interface.

• At least one MIDI instrument.

• Any audio equipment necessary to listen to the sound from your MIDI 
devices.
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Computer requirements 

Hardware – PC

The absolute minimum requirements for running Cubase SX/SL on a 
PC are as follows:

• A 500 MHz Pentium III with 256 MB of RAM or an equivalent AMD 
processor.
Recommended configuration for optimum performance: 1 GHz or faster PIII/Athlon with 
512 MB RAM.

RAM

Audio work requires a lot of RAM! In fact, there is a direct relation be-
tween the amount of available RAM and the number of audio channels 
that you can have running. As specified earlier, 256 MB is the minimum 
requirement, but as a general rule “the more the better” applies.

Hard disk size

• The size of the hard disk determines how many minutes of audio you 
will be able to record. 
Recording one minute of stereo CD quality audio, requires 10 MB of hard disk space. 
That is, eight stereo tracks in Cubase SX/SL use up at least 80 MB of disk space per 
recording minute.

Hard disk speed

The speed of the hard drive also determines the number of audio tracks 
you can run. That is the quantity of information that the disk can read, 
usually expressed as “sustained transfer rate”. Again, “the more the 
better” applies.

Wheel mouse

Although a regular mouse will work perfectly fine with Cubase SX/SL, 
we recommend that you use a wheel mouse, as this will speed up 
value editing and scrolling considerably. See page 160 and page 165.
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Audio hardware

Cubase SX/SL will run with audio hardware that meets the following 
basic specifications:

• Stereo.
• 16 bit.
• Support of at least the 44.1kHz sampling rate.
• Is supplied with a special ASIO driver, or a DirectX or Windows Multimedia 

compatible driver as described below.

About drivers

A driver is a piece of software that allows a program to communicate 
with a certain piece of hardware. In this case, the driver allows Cubase 
SX/SL to use the audio hardware. For audio hardware, there are three 
different cases, each requiring different driver configurations:

If the audio hardware has a specific ASIO driver

Professional audio cards often come with an ASIO driver written es-
pecially for the card. This allows for communication directly between 
Cubase SX/SL and the audio card. As a result, audio cards with spe-
cific ASIO drivers can provide lower latency (input-output delay), 
which is crucial when monitoring audio via Cubase SX/SL or using 
VST Instruments. The ASIO driver may also provide special support 
for multiple inputs and outputs, routing, synchronization, etc.

Audio card-specific ASIO drivers are provided by the card manufac-
turers. Make sure to check the manufacturer’s web site for the latest 
driver versions.

❐ If your audio hardware comes with a specific ASIO driver we strongly 
recommend that you use this.
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If the audio card communicates via DirectX

DirectX is a Microsoft “package” for handling various types of Multi-
media under Windows. Cubase SX/SL supports DirectX, or to be 
more precise, DirectSound, which is a part of DirectX used for playing 
back and recording audio. This requires two types of drivers:

• A DirectX driver for the audio card, allowing it to communicate with DirectX. If 
the audio card supports DirectX, this driver should be supplied by the audio 
card manufacturer. If it isn’t installed with the audio card, please check the 
manufacturer’s web site for more information.

• The ASIO DirectX Full Duplex driver, allowing Cubase SX/SL to communicate 
with DirectX. This driver is included with Cubase SX/SL, and does not require 
any special installation.

If the audio card communicates via Windows Multimedia system

If the card is Windows compatible, it can be used in Cubase SX/SL. 
The card then communicates with Windows Multimedia system, which 
in turn communicates with Cubase SX/SL. This requires two types of 
drivers: 

• A Windows Multimedia driver for the audio card, allowing it to communicate 
with the Windows Multimedia system. This driver should be supplied by the 
audio card manufacturer, and is normally installed when you install the audio 
card.

• The ASIO Multimedia driver, allowing Cubase SX/SL to communicate with the 
Windows Multimedia system. This driver is included with Cubase SX/SL, and 
does not require any special installation.
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Hardware installation

Installing the copy protection key – please read!

Included with the Cubase SX/SL package, you will find a hardware 
key (sometimes referred to as a “dongle”) that is part of the Cubase 
SX/SL copy protection scheme. Cubase SX/SL will not run if this key 
isn’t installed properly. Please note the following important points:

❐ The copy protection key should be plugged into the computer’s USB 
port after installing Cubase SX/SL and restarting the computer!

• The copy protection key should not be plugged in during the actual in-
stallation of Cubase SX/SL, nor should it be plugged in at any time 
before Cubase SX/SL is installed! 
When the copy protection key is plugged into the USB port, Windows will automati-
cally register it as a new hardware device and will attempt to find drivers for it – these 
necessary drivers won’t be there until Cubase SX/SL has been installed and the com-
puter restarted.

Installing the audio hardware and its driver

1. Install the audio card and related equipment in the computer, as de-
scribed in the card’s documentation.

2. Install the driver for the card.
There are three types of drivers that could apply: card-specific ASIO drivers, DirectX 
drivers and Windows Multimedia drivers.

Specific ASIO driver

If your audio card has a specific ASIO driver it may be included with 
the audio card, but you should always make sure to check the audio 
card manufacturer’s web site for the most recent drivers. For details 
on how to install the driver, refer to the manufacturer’s instructions.

DirectX driver

If your audio card is DirectX compatible, its DirectX drivers will most 
likely be installed when you install the card (as with the Windows Multi-
media driver). If you have downloaded special DirectX drivers for the au-
dio card, you should follow the manufacturer’s installation instructions.
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Windows Multimedia driver

These drivers are normally included with all types of regular PC audio 
cards. Some are even included with Windows itself. Depending on 
whether the audio card is “Plug’n’Play compatible” or not, the installa-
tion of the card is done differently:

• If the card is “Plug’n’Play compatible”, Windows will detect the 
card once it is plugged in, and ask for the necessary driver disks.

• If not, you need to use the “Add New Hardware” feature in the Control 
Panel to install the card and its drivers.
Refer to the documentation that comes with the card.

❐ Should you have an audio card but no driver, please check the manufac-
turers web site, or ask your music or computer dealer for help.

Testing the Card

To make sure the audio card will work as expected, perform the fol-
lowing two tests:

• Use any software included with the audio card to make sure you can 
record and play back audio without problems.

• If the card is accessed via a standard Windows driver, use the Media 
Player application (included with Windows) to play back audio.

Installing a MIDI interface/synthesizer card

Installation instructions for a MIDI interface should be included with 
the product. However, here’s an outline of the necessary steps:

1. Install the interface (or MIDI synthesizer card) inside your computer or 
connect it to a “port” (connector) on the computer.
Which is right for you depends on which type of interface you have.

2. If the interface has a power supply and/or a power switch, turn it on.

3. Install the driver for the interface, as described in the documentation 
that comes with the interface.
It is likely that you will need a CD ROM or floppy disk supplied by the manufacturer of 
the MIDI interface.
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Installing Cubase SX/SL

Defragment the hard disk

If you plan to record audio on a hard disk where you have already 
stored other files, now is the time to defragment it. Defragmentation 
reorganizes the physical allocation of space on the hard disk in order 
to optimize its performance. It is done with a special defragmentation 
program. In Windows XP, for example, you might look for the “Disk 
Defragmenter” utility.

❐ It is crucial to the audio recording performance that your hard disk is op-
timized (defragmented). You should make sure to defragment regularly.

Installing the files on the CD-ROM

The installation procedure puts all files in the right places, automatically.

1. Make sure that the hardware copy protection key is not plugged into 
the computer USB port.

2. Insert the Cubase SX/SL CD-ROM.

3. A pop-up dialog appears automatically, containing three items for in-
stalling, browsing the CD and exiting.
If this dialog doesn’t appear, open the CD-ROM on the desktop, and double click the 
“Autorun.EXE”.

4. To start the installation process, select “Install”.

A number of dialogs now appear:

• In one dialog you will need to fill in your name and the serial number of 
your Cubase SX/SL copy, and click OK.
You will find the serial number on the registration card that comes with the Cubase 
SX/SL package. Check the name and number in the confirmation dialog and click 
“Yes” if they are correct. Clicking “No” brings back the previous dialog.

5. Now the actual Cubase SX/SL installation procedure starts.
A number of dialogs will appear, allowing you to select in which folder on your hard 
disk you want to install the program, etc. To advance to the next “page” in the installa-
tion procedure, click the “Next” button. The “Previous” button takes you back to the 
previous page.
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• In one dialog you will be asked if you would also like to install earlier 
Cubase plug-ins. This is primarily intended to ensure compatibility 
with songs created with earlier versions, but will of course also give 
you a wider palette of plug-ins to choose from. You can either just se-
lect Yes or No and proceed, or click the Details button to select from 
a list where you can decide which plug-ins to install. At the bottom of 
the list there is an item named “Earlier Plug-ins”. If ticked, the plug-ins 
that came with versions prior to Cubase 5 will also be installed. 

6. Finally, a dialog box informs you that the installation was successful 
and recommends you to restart your computer.

7. After restarting the computer, plug in the hardware protection key into 
the USB port.
If you are unsure over which port this is, consult the computer’s documentation.

8. The first time the copy protection device is plugged in, it will be regis-
tered as a new hardware device, and a dialog will appear asking you 
whether you would like to find drivers for the device manually or auto-
matically. You should select to find drivers automatically.
The dialog closes.

9. You are now ready to launch Cubase SX/SL!
Remove the CD-ROM and store it in a safe place.

This completes the installation of your Cubase SX/SL program! 
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The items on the start menu

If you open the Windows Start menu, you will find a Cubase SX/SL 
group on the “Programs” submenu. This contains the following items:

• Documentation.
On this submenu you can access the “Getting Started”, “Operation Manual” and 
“Score Layout and Printing”(SX only) documentation in the Acrobat pdf format. These 
documents are also available on the Help menu from within the program.

• ASIO DirectX Full Duplex Setup.
This is where you make settings if your audio hardware uses DirectX for audio play-
back and recording.

• ASIO Multimedia Setup.
This opens a dialog with settings for the ASIO (Audio Stream Input Output) system, 
which handles audio recording and playback in Cubase SX/SL, if you are using the 
ASIO MME driver. This dialog can also be opened from within Cubase SX/SL. See the 
chapter “Setting up your system” in this book.

• Cubase SX/SL.
This launches the actual program. 

There may also be additional items (such as Readme files) available on 
the Start menu. Please read all such files before launching Cubase SX/
SL, since they may contain late information not included in the manuals.

• LCC.
This item shows all SyncroSoft protection devices and valid licences currently installed.
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About this chapter

This chapter describes the system requirements and installation pro-
cedures for Cubase SX/SL for Mac OS X. Installing Cubase SX/SL 
for Windows is described on page 14.

Requirements

To use Cubase SX/SL, you need the following:

• A Macintosh computer running Mac OS X (version 10.2 or later).
A USB Port is also required.

For more details about the computer requirements, see below.

• Mac OS X compatible audio hardware.
While the built-in audio hardware of the Macintosh may be adequate for basic audio 
playback, we strongly recommend audio hardware that is specifically designed for au-
dio recording and music applications.

For MIDI

• At least one MIDI interface.

• At least one MIDI instrument.

• Any audio equipment necessary to listen to the sound from your MIDI 
devices.
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Computer requirements 

Hardware – Mac

The absolute minimum requirements for running Cubase SX/SL on a 
Macintosh are as follows:

• Macintosh with a G4 processor, 256 MB RAM and OS X 10.2.
We recommend 512 MB RAM or more.

RAM

Audio work requires a lot of RAM! In fact, there is a direct relation be-
tween the amount of available RAM and the number of audio channels 
that you can have running. As specified earlier, 256 MB is the minimum 
requirement, but as a general rule “the more the better” applies.

Hard disk size

• The size of the hard disk determines how many minutes of audio you 
will be able to record. 
Recording one minute of stereo CD quality audio, requires 10 MB of hard disk space. 
That is, eight stereo tracks in Cubase SX/SL use up at least 80 MB of disk space per 
recording minute.

Hard disk speed

The speed of the hard drive also determines the number of audio 
tracks you can run. That is the quantity of information that the disk can 
read, usually expressed as “sustained transfer rate”. Again, “the more 
the better” applies.

Mouse

Although a regular mouse will work perfectly fine with Cubase SX/SL, 
we recommend that you use a wheel mouse with two mouse buttons.

• Having a wheel mouse will speed up value editing and scrolling considerably.
• If your mouse has two mouse buttons you should program the right mouse 

button to generate a [Ctrl]-click (this is typically the default behaviour of the 
right mouse button). 
This will allow you to bring up context menus by right clicking (see page 157).
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Audio hardware

Cubase SX/SL will run with audio hardware that meets the following 
basic specifications:

• Stereo.
• 16 bit.
• Support of at least the 44.1kHz sampling rate.
• Is supplied with proper Mac OS X (Core Audio) drivers.

A basic rule of thumb is: if the hardware works under Mac OS X, you 
can use it in Cubase SX/SL.

• Cubase SX/SL also supports audio hardware with Mac OS X compliant 
ASIO drivers.
ASIO drivers may provide special support for routing, monitoring, synchronization, etc. 
Note that the ASIO drivers must be written specifically for Mac OS X - Mac 9.X ASIO 
drivers cannot be used.

Using the built-in audio hardware of the Macintosh

As of this writing, all current Macintosh models have built-in 16 bit ste-
reo audio hardware. Depending on your preferences and requirements, 
this may be sufficient for use with Cubase SX/SL (although we recom-
mend using multi-output audio hardware). The built-in audio hardware 
is always available for selection in Cubase SX/SL - you don’t need to 
install any additional drivers.

❐ Some Macintosh models have audio outputs but no inputs. This means 
that you can only play back audio - recording is not possible without ad-
ditional audio hardware.
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Hardware installation

About the copy protection key – please read!

Included with the Cubase SX/SL package, you will find a hardware 
key (sometimes referred to as a “dongle”) that is part of the Cubase 
SX/SL copy protection scheme. Cubase SX/SL will not run if this key 
isn’t installed properly. Please note the following important points:

❐ You should first install the program (and any necessary hardware, see be-
low), then insert the copy protection key and finally launch the program.

The copy protection key should not be plugged in during the actual in-
stallation of Cubase SX/SL, nor should it be plugged in at any time 
before Cubase SX/SL is installed! This is because the necessary driv-
ers for the key are installed when you install the program.

Installing the audio hardware and its driver

1. Make sure you have the latest Mac OS X drivers for the audio hardware!
Please check the manufacturer’s web site for the latest versions.

2. Install the driver(s) for the audio hardware.
This is usually done by running an installer application.

3. Install or connect the audio interface, as described in the card’s doc-
umentation.

Installing a MIDI interface

1. Make sure you have the latest Mac OS X drivers for the MIDI interface!
Please check the manufacturer’s web site for the latest versions.

2. Install the driver(s) for the interface.
This is usually done by running an installer application.

3. Connect the MIDI interface to the computer, as described in the inter-
face documentation.
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Installing Cubase SX/SL

Defragment the hard disk

If you plan to record audio on a hard disk where you have already 
stored other files, now is the time to defragment it. Defragmentation 
reorganizes the physical allocation of space on the hard disk in order 
to optimize its performance. It is done with a special defragmentation 
program.

❐ It is crucial to the audio recording performance that your hard disk is op-
timized (defragmented). You should make sure to defragment regularly.

Installing the files on the CD-ROM

The installation procedure puts all files in the right places, automatically.

1. Make sure that the hardware copy protection key is not plugged into 
the computer USB port.

2. Insert the Cubase SX/SL CD-ROM.

3. Open and read the file “Read Me First” before continuing.
This may contain late braking news pertinent to the installation.

4. Locate the Cubase SX/SL installer and run it.
The installation procedure starts. This will create a Cubase SX/SL folder in your Appli-
cations folder and add various required files to your system.

• At one point during the installation you will need to fill in your name 
and the serial number of your Cubase SX/SL copy.
You will find the serial number on the registration card that comes with the Cubase SX/
SL package.

• In one dialog you will be asked if you would also like to install earlier 
Cubase plug-ins.
This is primarily intended to ensure compatibility with songs created with earlier ver-
sions, but will of course also give you a wider palette of plug-ins to choose from.

• Note: the earlier Cubase plug-ins have not been extensively tested under 
Mac OS X.
They should be considered as a “bonus feature”, to be used at the user’s own risk.
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Finally, a dialog box informs you that the installation was successful.

5. Plug in the hardware protection key into a free USB port.
If you are unsure over which port this is, consult the computers documentation.

6. You are now ready to launch Cubase SX/SL!
Remove the CD-ROM and store it in a safe place.

This completes the installation of your Cubase SX/SL program! 

You can now start the program from your Applications folder. When 
you launch Cubase SX/SL for the first time, you will be asked whether 
you want to add a Cubase SX/SL icon to the Dock.
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Setting up audio

❐ Always make all connections with all equipment turned off!

Connecting audio

Exactly how to set up your system is a very personal matter, the follow-
ing connection diagrams should be taken as examples.

The audio connections below may be digital or analog, it doesn’t matter.

Stereo input and output – the simplest connection

If you only use a stereo input and output from Cubase SX/SL, you 
might connect your audio hardware directly to the input source, a 
mixer for example, and the outputs to a power amplifier and speaker.

A simple stereo audio setup.

Audio card inputs

Audio card outputs

Amplifier and speakersSource to be recorded

L R

L R
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Multi-channel input and output

Most likely however, you will have other audio equipment that you 
want to integrate with Cubase SX/SL. This will require a mixer, prefer-
ably one with a group or bus system that can be used for feeding in-
puts on the audio hardware.

In the example below, four buses are used for feeding signals to the 
sound hardware’s inputs. The four outputs are connected back to the 
mixer for monitoring and playback. Remaining mixer inputs can be used 
for connecting audio sources like microphones, instruments, etc.

A multi-channel audio setup.

• When connecting an input source (like a mixer) to the audio hardware, 
you should use output buses, sends or similar that are separate from the 
mixer’s master output to avoid recording what you are playing back.

Audio    card inputs

Audio card outputs

Amplifier and speakersMixer

Inputs
1 to 4

Bus
1 to 4 L R
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Connecting for surround sound (SX only)

If you plan to mix for surround sound, you could connect the audio 
outputs to a multi-channel power amplifier, driving a set of surround 
channels.

A surround sound playback configuration.

Cubase SX supports a number of surround formats. The example con-
nection above will work for mixing both 5.1 and LRCS (ProLogic for 
example) where in this case the two surround speakers will be playing 
the same material (from the single surround channel). The only differ-
ence between the two formats in this aspect is the LFE channel, which 
is not used with LRCS.

Recording from a CD player

Most computers come with a CD-ROM drive that can also be used as 
a regular CD player. In some cases the CD player is internally con-
nected to the audio hardware so that you can record the output of the 
CD player directly into Cubase SX/SL (consult the audio hardware 
documentation if you are uncertain).

• All routing and level adjustments for recording from a CD (if available) are 
done in the audio hardware setup application (see page 35).

• You can also grab audio tracks directly from a CD in Cubase SX (see the 
Operation Manual). 

Audio card inputs

Audio card outputs

Amplifier and speakersSource to be recorded

L R

RCL

Rs/S

LFE

Ls/S
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Word Clock connections

If you are using a digital audio connection you may also need a word 
clock connection between the audio hardware and external devices. 
Please refer to the documentation that came with the audio hardware 
for details.

❐ It is very important that word clock synchronization is done correctly or 
there might be clicks and crackles in recordings that you make!

Driver and helper application setup

The audio hardware setup application

Most audio cards come with one or more small applications that allow 
you to configure the inputs of the hardware to your liking. 
This includes:

• Selecting which in/outs are active.
• Setting up word clock synchronization (if available).
• Turning monitoring via the hardware on/off (see page 40).
• Setting levels for each input. This is very important!
• Setting levels for the outputs, so that they match the equipment you use for 

monitoring.

For more details about your audio hardware setup application please 
refer to the documentation that came with the hardware.
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VST Multitrack setup – Basic Settings

1. In Cubase SX/SL, select Device Setup from the Devices menu and 
click on VST Multitrack in the list.
Make sure the “Setup” tab is selected.

The VST Multitrack panel in the Device Setup dialog.

2. Select your audio hardware from the ASIO Driver menu.
There may be several options here that all refer to the same audio hardware:

❐ Under Windows we strongly recommend that you access your hardware 
via an ASIO driver written specifically for the hardware, if available. If no 
ASIO driver is installed we recommend that you check with your audio 
hardware manufacturer if they have an ASIO driver available, for exam-
ple for download via the Internet.

3. Bring up the control panel for the audio hardware and adjust the set-
tings as recommended by the audio hardware manufacturer.
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• Under Windows, you can open the control panel by clicking the Con-
trol Panel button in the VST Multitrack panel.
The control panel that appears when you click this button is provided by the audio 
hardware manufacturer and not Cubase SX/SL (unless you use DirectX or MME, see 
below). Hence it will be different for each audio card brand and model. The settings 
may include options for buffering, synchronization, digital input and output formats etc.

The Control panels for the ASIO Multimedia and ASIO DirectX drivers are an excep-
tion, as they are provided by Steinberg. They are described in the HTML Help, opened 
by clicking the Help button in the respective dialog. See also the notes below.

• Under Mac OS X, you will find the control panel for your audio hard-
ware in the System Preferences (“Other” section), opened from the 
Apple menu or from the Dock.
If you are using the built-in audio hardware of the Macintosh, you use the “Sound” con-
trol panel in the System Preferences to set levels, balance, etc.
If you are using ASIO audio hardware, you can click the Control Panel button to bring 
up its panel.

4. If you plan to use several audio applications simultaneously, you may 
want to activate the option “Release ASIO Driver in Background”. 
This will allow another application to play back via your audio hard-
ware even though Cubase SX/SL is running.
The application that is currently active (i.e. the “top window” on the desktop), will get 
access to the audio hardware. Make sure that any other audio application accessing 
the audio hardware is also set to release the ASIO (or Mac OS X) driver so Cubase 
can use it when becoming the active application again.

5. If your audio hardware and its driver support ASIO Direct Monitoring, 
you may want to activate the Direct Monitoring checkbox.
Read more about monitoring later in this chapter and in the Recording chapter in the 
Operation Manual.

6. Click Apply and then OK to close the dialog.
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If you are using audio hardware with a DirectX driver (Windows only)

❐ If your Windows audio hardware doesn’t have a specific ASIO driver, a 
DirectX driver is the next best option.

There is an ASIO DirectX driver available with Cubase SX/SL, “ASIO 
DirectX Full Duplex”. This driver allows both audio recording and play-
back. However:

• To be able to take full advantage of DirectX Full Duplex, the audio hard-
ware must support WDM (Windows Driver Model) in combination with 
DirectX version 7 or higher (8.1 recommended for Windows 2000 – see 
below). 
In all other cases, the audio inputs will be emulated by DirectX (see the HTML Help for 
the ASIO DirectX Full Duplex Setup dialog for details about how this is reported). 
Since using emulated inputs will result in higher latency, you may want to use the ASIO 
Multimedia driver instead, as this gives you more possibilities to fine-tune the settings.

❐ Windows 2000 users should use DirectX version 8.1. An installer is pro-
vided on the Cubase SX/SL Program CD.

When the ASIO DirectX Full Duplex driver is selected in the Device 
Setup you can open the ASIO Control Panel and adjust the following 
settings (for more details, click the Help button in the control panel):

• Direct Sound Output and Input Ports
In the list to the left in the window, all available Direct Sound Output and Input Ports 
are listed. In many cases, there will only be one Port in each list. To activate or deacti-
vate a Port in the list, click the check box in the left column. If the check box is ticked, 
the port is activated.

• You can edit the Buffer Size and Offset settings in this list if necessary, by 
double clicking on the value and typing in a new value. 
In most cases the default settings will work fine. The audio buffer is used when audio 
data is transferred between Cubase SX/SL and the audio card. Having a large buffer 
ensures that playback will occur without glitches. However, the time between the mo-
ment Cubase SX/SL sends out the data and when it actually reaches on the output the 
"latency" will be longer.

• Offset
If a constant offset is audible during playback of audio and MIDI recordings, you can 
adjust the output or input latency time using this value.
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If you are using audio hardware with a Windows Multimedia (MME) driver

When you select the ASIO Multimedia Driver for the first time, the sys-
tem will ask you whether you want to test the configuration. We strongly 
recommend that you perform this test. If it fails, or if you for other rea-
sons need to make adjustments to your ASIO Multimedia configuration, 
click the Control Panel button to open the ASIO Multimedia Setup con-
trol panel included with Cubase SX/SL. This control panel comes with 
an HTML Help describing the features and procedures.

About recording levels and inputs

When you connect your equipment, you should make sure that the im-
pedance and levels of the audio sources and inputs are matched. 
Typically, different inputs may be designed for use with microphones, 
consumer line level (-10 dBV) or professional line level (+4 dBV), or 
you may be able to adjust input characteristics on the audio interface 
or in its control panel. Please check the audio hardware documenta-
tion for details.

Using the correct types of input is important to avoid distortion or 
noisy recordings.

❐ Cubase SX/SL does not provide any input level adjustments, since these 
are done differently for each card. Adjusting input levels is either done in 
a special application included with the hardware or possibly from its 
Control Panel.
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About monitoring

In Cubase SX/SL, monitoring means listening to the signal being re-
corded while preparing to record or while recording. There are basi-
cally three ways to monitor:

External monitoring

External monitoring (listening to the input signal before it goes into 
Cubase SX/SL) requires an external mixer for mixing the audio play-
back with the input signal. This mixer could be a stand-alone physical 
mixer or a mixer application for your audio hardware, if this has a mode 
in which the input audio is sent back out again (usually called “Thru”, 
“Direct Thru” or similar).

Via Cubase SX/SL

In this case, the audio passes from the input into Cubase SX/SL, pos-
sibly through Cubase SX/SL effects and EQ and then back to the out-
put. You then control monitoring via settings in Cubase SX/SL.

This is useful for monitoring an input signal with effects added by 
Cubase SX/SL. Keep in mind that the latency of your audio card 
drivers may delay the output (see page 46).

ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO 
Direct Monitoring (this feature may also be available for audio hard-
ware with Mac OS X drivers). In this mode, the actual monitoring is 
done in the audio hardware, by sending the input signal back out 
again. However, monitoring is controlled from Cubase SX/SL. This 
means that the audio hardware’s direct monitoring feature can be 
turned on or off automatically by Cubase SX/SL.

Monitoring is described in detail in the Recording chapter in the Oper-
ation Manual. However, when setting up, there’s one thing to note:

• If you want to use the external monitoring via your audio hardware, 
make sure the corresponding functions are activated in the card’s 
mixer application.
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Setting up MIDI

❐ Always make all connections with all equipment turned off!

This section describes how to connect and set up MIDI equipment. If 
you have no MIDI equipment you can skip this section.

Connecting the MIDI equipment

Below follows a description of a typical but small setup example. You 
might need or want to hook things up differently!

In this example we assume that you have a MIDI keyboard and an ex-
ternal MIDI sound module. The keyboard is used both for feeding the 
computer with MIDI messages for recording and for playing back MIDI 
tracks. The sound module is used for playback only. Using Cubase 
SX/SL’s MIDI Thru feature (described later) you will be able to hear 
the correct sound from the sound module while playing the keyboard 
or recording.

A typical MIDI Setup.

MIDI Keyboard

MIDI Sound Module

MIDI
Interface

MIDI

MIDI

In

MIDI In

Out

OutIn

Thru
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You might want to use even more instruments for playback. If you do, 
simply connect MIDI Thru on the sound module to MIDI In on the next 
instrument, and so on. In this hook-up, you will always play the first 
keyboard when recording. But, you can still use all your devices for 
providing sounds on playback.

❐ If you plan to use more than three sound sources we recommend that 
you either use an interface with more than one output, or a separate 
MIDI Thru box instead of the Thru jacks on each unit.

Setting MIDI Thru and Local On/Off

In the “MIDI” section in the Preferences dialog (located on the File menu 
under Windows and on the Cubase SX/SL menu under Mac OS X), you 
will find a setting called “MIDI Thru Active” which can be enabled or not. 
This is related to a setting in your instrument called “Local On/Off” or 
“Local Control On/Off”.

• If you use a MIDI keyboard instrument, as described earlier in this chapter, MIDI 
Thru should be activated and that instrument should be set to Local Off (some-
times called Local Control Off – see the instrument’s operation manual for de-
tails). This will let the MIDI signal from the keyboard get recorded into Cubase 
SX/SL and at the same time re-routed back to the instrument so that you hear 
what you are playing, without the keyboard “triggering” its own sounds.
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• If you use a separate MIDI keyboard, that does not produce any sounds itself, 
MIDI Thru in Cubase SX/SL should also be activated, but you don’t need to 
look for any Local On/Off setting in your instruments.

• The only case where MIDI Thru should be deactivated is if you use Cubase 
SX/SL with only one keyboard instrument and that instrument cannot be set 
to Local Off mode.

• Note that MIDI Thru will only be active for MIDI tracks that are record enabled. 
See the Recording chapter in the Operation Manual for more information.

MIDI Keyboard

MIDI Sound Module

MIDI
Interface

MIDI

MIDI

In

MIDI In

Out

OutIn

Thru

“Synth” 

When “MIDI Thru” is active in Cubase SX/
SL, MIDI data received is immediately “ech-
oed” back out.

When you press a key, it is sent 
out via MIDI to Cubase SX/SL.

MIDI data coming in to the instrument 
is played by the “Synth” inside it.

When Local Control is On in the instrument, the 
keys you press will be played by the “Synth” in-
side the Instrument.
When Local Control is turned Off, this connec-
tion is cut off.
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Setting up MIDI ports in Cubase SX/SL

The Device Setup dialog lets you set up your MIDI system in the fol-
lowing ways:

• Note: After changing a setting in the Device Setup dialog, you should 
click Apply and then click OK to close the dialog.

Showing or hiding MIDI Ports

Under Windows, the MIDI ports are listed in the Device Setup dialog 
on the DirectMusic page and/or the Windows MIDI page (depending 
on your system). By clicking in the “Show” column for a MIDI input or 
output, you can specify whether or not it should be listed on the MIDI 
pop-up menus in the program.

Under Mac OS X, you can hide or show MIDI ports on the MIDI Sys-
tem page in the Device Setup dialog.

• Hiding a MIDI port from view does not turn it off if it’s already selected for 
a track or a MIDI device.

Setting up the “All MIDI Inputs” option

When you record MIDI in Cubase SX/SL, you can specify which MIDI 
input each recording MIDI track should use. However, you can also 
select the “All MIDI Inputs” option, which causes any MIDI data from 
any MIDI input to be recorded.

The All MIDI Inputs page in the Device Setup dialog allows you to spec-
ify which inputs should be included when you select All MIDI Inputs for 
a MIDI track. This can be especially useful if your system provides sev-
eral instances of the same physical MIDI input - by deactivating the du-
plicates you make sure only the desired MIDI data is recorded.

Setting up a default MIDI input and output

The Default MIDI Ports page in the Device Setup dialog allows you to 
select which MIDI ports should be selected by default when create a 
new MIDI track. In other words, newly created tracks will always use 
the input and output specified on this page. However, you can later 
change this setting for each individual track in the Project window.
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Connecting a synchronizer

❐ Always make all connections with all equipment turned off!

When using Cubase SX/SL with external tape transports you will most 
likely need to add a synchronizer to your system. All connections and 
setup procedures for synchronization are described in the Synchroni-
zation chapter in the Operation Manual.

Setting up video

❐ Always make all connections with all equipment turned off!

Cubase SX/SL plays back video films in AVI, Quicktime or MPEG for-
mats. Under Windows, video playback can be done using one of three 
playback engines: Video for Windows, DirectShow or Quicktime. Un-
der Mac OS X, Quicktime is always used as playback engine. This en-
sures compatibility with as wide a range of video hardware as possible. 
Generally there are three ways to play back video:

• Without any special hardware at all, using the computer CPU.
In this case, the “codec” is in software. While this will be fine in many situations it does 
put a limit on the size of the video window as well as the quality of the image.

• Using video hardware that for example connects to an external monitor.
This hardware (which could be installed within the computer or e.g. connected via 
FireWire) must then have use a suitable codec and have the proper drivers. Please 
visit the Steinberg home page for more information about video hardware support.

If you plan to use special video hardware, install it and set it up as 
recommended by the manufacturer.

Before you use the video hardware with Cubase SX/SL, we recom-
mend that you test the hardware installation with the utility applications 
that came with the hardware and/or the Windows Media Player or 
Quicktime Player (Mac OS X) applications.
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Optimizing audio performance

This section of the chapter gives you some hints and tips on how to get 
the most out of your Cubase SX/SL system, performance-wise. Some 
of this text refers to hardware properties and can be used as a guide 
when upgrading your system. This text is very brief. Look for details and 
current information on the Cubase SX/SL web site (see page 12)!

Two aspects of performance

There are two distinct aspects of performance in respect to Cubase 
SX/SL:

Tracks and effects

Simply put: the faster your computer, the more tracks, effects and EQ 
you will be able to play. Exactly what constitutes a “fast computer” is a 
science almost in itself, but some hints are given below.

Short response times (latency)

Another aspect of performance is response times. Latency is a phenom-
enon based on the fact that in a computer, audio has to be “buffered” 
(stored) in small chunks during various steps of the recording and play-
back process. The more and larger those chunks, the higher the latency.

High latency is most troublesome when playing VST Instruments and 
when monitoring through the computer, that is when listening to a live 
audio source via the Cubase SX/SL Mixer and effects. However, very 
long latency times (several hundred milliseconds) can hamper other 
processes like mixing, since e.g. a fader movement will affect the au-
dio noticeably late.

While Direct Monitoring and other techniques reduce the problems 
associated with very long latency times, a system that responds fast 
will always be more convenient to work with.

• Depending on your audio hardware, it may be possible to “trim” your 
latency times, usually by lowering the size and number of buffers.
For details, refer to the audio hardware documentation, or, if you are using a DirectX or 
MME driver under Windows, the HTML Help.
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System factors that affect performance

CPU and processor cache

It goes without saying that the faster the computer processor, the bet-
ter. But there are a number of factors that affect the apparent speed of 
a computer: the bus speed and type (PCI is strongly recommended), 
the processor cache size and of course, the processor type and brand.

Cubase SX/SL relies heavily on floating point calculations. When 
shopping for a processor, please make sure you get one that is pow-
erful in calculating floating point arithmetics.

Hard disk and controller

The number of hard disk tracks you can record and play back at the 
same time also depends on the speed of your hard disk and hard disk 
controller. If you use E-IDE disks and controllers, make sure that the 
transfer mode is DMA Busmaster. Under Windows, you can check the 
current mode by launching Windows Device Manager and looking for 
properties of the IDE ATA/ATAPI Controller’s primary and secondary 
channel. DMA transfer mode is enabled by default, but may be turned 
off by the system should hardware problems occur.

Audio hardware and driver

The hardware and its driver can have some effect on regular perfor-
mance. A badly written driver can reduce the performance of your com-
puter. But where the hardware driver design makes the most difference 
is with latency.

❐ Again, we strongly recommend that you use audio hardware for which 
there is a specific ASIO driver!

This is especially true when using Cubase SX/SL for Windows:

• Under Windows, ASIO drivers written specifically for the hardware are more 
efficient than MME or DirectX and normally produce shorter latency times.

• Under Mac OS X however, audio hardware with properly written Mac OS X 
(Core Audio) drivers can be very efficient and produce very low latency times.
Still, there are additional features currently only available with ASIO drivers, such as 
ASIO Positioning Protocol.
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Making settings that affect performance

Choosing a driver for your audio hardware

As described on page 36, it is recommended to install and use a stan-
dard ASIO driver if available for your specific hardware. Check the 
manufacturers web site for the latest drivers etc.

Making disk buffer settings

These settings can be found in the VST Multitrack panel in the Device 
Setup dialog (opened from the Devices menu). The two parameters 
“Number of Disk Buffers” and “Disk Buffer Size” govern how data is 
read and written from/to the hard disk.

When data is read from disk it is stored in a buffer. Since the com-
puter has to fill the buffer at the same time as it is playing back data, 
there needs to be more than one buffer. The same is true for record-
ing. You can adjust both the number of buffers used for each audio 
channel and their size.

With more and larger buffers, you will get smoother performance, 
since less computer processing power is “wasted” to accessing the 
hard disk (it can to some extent compensate for a slower processor). 
However, enlarging the values also raises latency and requires you to 
have proportionately greater amount of RAM.
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Making audio buffer settings

Audio buffers affect how audio is sent to and from the audio hard-
ware. The size of the audio buffers affect both the latency and the au-
dio performance. Generally, the smaller the buffer size, the lower the 
latency. On the other hand, working with small buffers can be de-
manding for the computer. If the audio buffers are too small, you may 
get clicks, pops or other audio playback problems.

• Under Mac OS X, you can adjust the size of the buffers on the VST Multitrack 
page in the Device Setup dialog.
You may also find buffer settings in the control panel for the audio hardware.

• Under Windows, you adjust the buffer size settings in the control panel for the 
audio hardware (opened by clicking the Control Panel button on the VST Mul-
titrack page in the Device Setup dialog).

The Expert settings

In the VST Multitrack panel you will find a button called “Expert…”. 
Normally you will not need to touch these settings, but if you run into 
problems with audio playback you should investigate whether chang-
ing these settings will help you. Generally, they allow you to adjust 
how much processing power is used for recording and playing back 
audio. See the Help for details.
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Optimizing processor scheduling (Windows only)

To get the lowest possible latencies when using ASIO under Windows 
2000 or XP (on a single CPU system), the 'system performance' has to 
be optimized for background tasks: 

Windows 2000

1. Open the Control Panel from the Start menu and select System.

2. Select the Advanced tab and click the Performance Options button.

3. In the dialog that appears, select “Optimize performance for: Back-
ground services”.

4. Click OK to close the dialogs.

Windows XP

1. Open the Control Panel from the Start menu and select System.

2. Select the Advanced tab and click the Settings button in the Perfor-
mance section.
The Performance Options dialog appears.

3. Select the Advanced tab.

4. In the Processor Scheduling section, select “Adjust for best perfor-
mance of: Background services”

5. Click OK to close the dialogs.

Related Information (Windows only)

ACPI vs. Standard PC mode

Windows 2000 users should consider the important information relat-
ing to audio performance as presented on the Steinberg Knowledge 
Base. The address is “http://service.steinberg.net/knowledge.nsf/
show/acpi_kills_audio_performance”. 
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The main windows in Cubase SX/SL

The Project window

The Project window is the main window in Cubase SX/SL. This pro-
vides you with a graphic overview of the project, allowing you to navi-
gate and perform large scale editing. The Project window is divided 
vertically into tracks and has a time line going from left to right. Each 
project has one Project window.

The Track list with 
various track types.

The project cursor.

The area with various track 
settings to the left is called the 
Inspector.

The area to the right in the project win-
dow is called the event display. This is 
where you view and edit audio and MIDI 
events, automation curves, etc.
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The Project Browser

The Project Browser provides a list based representation of the project. 
This allows you to view and edit all events on all tracks by using regular 
value editing in a list.

The Transport panel

The Transport panel features transport controls, much like those found 
on a conventional tape recorder. It can also be used for setting tempo 
and time signature, etc.

The Tempo and Time Signature display.Position display.

Transport controls.
The Left and Right Locators are used 
for defining where to start and end re-
cording and what section to cycle.
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The Pool

All files, audio or video, that belong to a project are listed in the Pool. 
There is a separate Pool for every project. In the Pool you can orga-
nize, convert and audition clips, amongst many other things.

Audio folder

Trash folder Video folder

Audio clips

Waveform image
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The Sample Editor

In the Sample Editor you can view and manipulate audio, by cutting 
and pasting, removing or drawing audio data. By using the Offline 
Process History, you can undo changes or revert to the original ver-
sions at any point.

Thumbnail overview.

Waveform view. A selected range.
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The MIDI editors

Editing MIDI data is done using the MIDI Editors. The following editors 
are available:

Key Editor

The Key Editor shows the contents of a single MIDI Part. The MIDI 
notes are represented by “boxes”, whose vertical position corresponds 
to their pitch.

This box represents a MIDI note.

This section is called the controller display. It shows “continuous” MIDI Events 
(such as Controllers) or as in this figure, the velocity values of notes.
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Score Editor

The Score Editor shows MIDI notes as a musical score and comes 
with advanced tools and functions for notation, layout and printing. 

❐ Full Score editing (as described in the “Score Layout and Printing” pdf 
documentation) is only available in Cubase SX.

List Editor

The List Editor shows all events in a MIDI part as a list, allowing you to 
view and edit their properties numerically.
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Drum Editor

The Drum Editor is similar to the Key Editor, but takes advantage of 
the fact that with drum parts, each key corresponds to a separate 
drum sound. 
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Tempo Track Editor

For each audio and MIDI track, you can specify whether it should use a 
musical or linear Time base. Tempo based tracks follow a tempo, which 
can either be fixed through the whole project or follow the Tempo Track. 
In the Tempo Track Editor you can draw curves that determine how the 
tempo will change over time.

Time Signature events

The Tempo curve
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The Mixer

The Mixer is where you mix your audio and MIDI channels, that is, ad-
just the levels (volume), stereo panning, effect sends, EQ, etc.

• Although there is a single Mixer, you can open two different mixer win-
dows and set these up to show different views of the Mixer.
This allows you to e.g. control all disk (audio track) channels in one window and all VST 
Instrument channels in another.

The Common panel contains settings 
that affect all mixer channels.

Level fader

Level meter Pan control
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Channel Settings

The Channel Settings window is used for adding effects and EQ to in-
dividual audio channels. Each audio channel has its own Channel set-
tings window. 

Inserts section
(only 5 in Cubase SL)

Equalizer section Sends section
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VST Send Effects

The VST Send Effects “rack” is where you select and activate Send 
Effects. There is a similar window for selecting and activating effects 
in the master output path.
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VST Outputs and Master Gain

In the VST Outputs window you can set the output level of each out-
put bus. The number of buses depends on your audio hardware.

The output level of the master bus is controlled with the Master Gain 
fader in the Mixer. The master bus may be in stereo or have several 
channels, depending on the chosen configuration. It is connected to 
the corresponding number of VST Output buses.

Stereo bus 
faders

Bus Active 
button

Bus output routing pop-up. This is where each output bus 
is routed to a physical output on the audio hardware.

The master bus and 
Master Gain fader in a 
stereo configuration.

The master bus and Master Gain fader 
in a multi-channel (surround) configura-
tion (surround configurations are avail-
able in Cubase SX only).
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Introduction

This chapter is intended as a quick start for users that are familiar with 
previous versions of Cubase. 

Firstly, we will outline some of the more basic concept differences be-
tween Cubase SX/SL and earlier versions of Cubase, to help seasoned 
Cubase users to quickly find their way around in this new environment! 
Secondly, some of the main new features are also briefly described in 
this chapter.

❐ You can import Songs and Arrangements created with previous versions 
of Cubase into Cubase SX/SL. Before you attempt to do this, you should 
read through the section “Importing older Cubase files” in the Operation 
Manual – File Handling chapter.

What is the fundamental difference?

Basically everything is new in Cubase SX/SL. Cubase SX/SL are not 
updated Cubase versions - they have been completely redesigned. 
While this is mostly transparent to the user – the main working areas 
of the program are still very similar – there are still changes in how re-
corded files are handled, changes in terminology used, the main menu 
structure is different etc.

While this may be slightly confusing initially to users of previous ver-
sions of Cubase, the advantages will soon become very apparent. 
Once the basic concept differences have been overcome, we feel 
certain that you will never look back!
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Songs and Arrangements

The basic concept of Songs and Arrangements is no longer used.

Instead, the native document format of Cubase SX/SL is called a 
project (Windows file extension “.cpr”). All settings, file references 
etc. relating to the project are stored in the project folder which is 
designated when you create a project. You can have several open 
projects, but only one can be active at a time. 

Can’t I work with multiple Arrangements in the way I’m used to?

Of course you can. As several projects can share the same project 
folder, having different formats for Songs and Arrangements is redun-
dant. Simply create new projects and designate them to use the same 
project folder.

For information about creating a project and the file and folder struc-
ture of a project, see page 150.

Project window vs. Arrange window

Cubase SX/SL’s main working area, the Project window, is compara-
ble to the ‘Arrange’ window in earlier Cubase versions. It allows real-
time placement of audio, video and MIDI parts and performing of al-
most all primary editing tasks, including automation as well as giving 
an overview of the entire project. Please read the chapter “Tutorial 4: 
Editing in the Project window” for a tutorial covering the basic editing 
procedures in the Project window.
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Audio related differences

Files and segments

Cubase SX/SL uses different terminology for referencing audio files in 
a project. Please read through the section Audio terminology on page 
152 to familiarize yourself with the basic terms used in Cubase SX/SL.

About audio channels

• You do not have to specify the number of audio channels to use in a 
project nor do you have to designate an audio channel to record on in 
Cubase SX/SL. 
You can simply create as many audio tracks you need in any project (limited only to 
what your computer can handle).

• In Cubase SX/SL, an audio track and an audio channel is the same 
thing. 
All audio tracks will have a corresponding audio channel strip in the Mixer.

Recording audio

In former Cubase versions, recording normally happened on the se-
lected track. 

• In Cubase SX/SL, you simply activate the Record Enable button for 
each track you wish to record on. How many you can record at a time 
depends on the number of activated inputs on your audio hardware.
You can also set things up so that selected tracks are automatically record enabled.

Events/parts

In Cubase SX, audio events can appear directly on audio tracks in the 
Project window, with no need for audio parts. You can also put one or 
several audio events into an audio part – this is useful for grouping 
events together and e.g. moving them as one unit.



CUBASE SX/SL
Quick start for former Cubase users 6 – 69

Dynamic events

There are no dynamic events for audio events anymore. Instead, 
please use the regular automation features to automate volume and 
pan. The Match Points feature in previous Cubase versions has been 
replaced by a comprehensive Hitpoint editing feature (see page 72).

Applying processing (SX only)

In Cubase SX/SL you can of course use plug-in effects in real time, 
just as before. But in Cubase SX you can also permanently apply the 
effect processing to selected audio events which can be very useful. 
This is described in the Operation Manual chapter “Audio processing 
and functions”.

MIDI related differences

Recording MIDI

In former Cubase versions, recording normally happened on the se-
lected track. 

• In Cubase SX/SL, recording happens on all tracks that are record en-
abled. 
You can also set things up so that selected tracks are automatically record enabled.

• The MIDI input can be set separately for each MIDI track in Cubase 
SX/SL.
The MIDI input was global for all tracks in previous versions of Cubase.

Setting MIDI Thru

To be able to play a connected MIDI instrument, MIDI Thru must be 
activated. This is activated either by record enabling the track or by 
clicking the Monitor button for the track.

Editing MIDI

In previous versions of Cubase, you could select a MIDI track in the 
Track list and open it in a MIDI editor. In Cubase SX, you need to se-
lect one or several parts on the track to be able to open a MIDI editor.



CUBASE SX/SL
6 – 70 Quick start for former Cubase users

Play Parameters

Cubase SX/SL features greatly extended real time processing of MIDI 
data. Cubase SX/SL comes with a number of MIDI effect plug-ins, ca-
pable of transforming the MIDI output from a track in various ways. 
MIDI effects are described in the Operation Manual chapter “MIDI re-
altime parameters and effects”.

However, unlike the Play Parameters in previous Cubase versions, 
track parameters in Cubase SX cannot be applied to individual MIDI 
parts. Instead, they are always set up for complete MIDI tracks.

Drum tracks

There is no specific track class for drums. Instead, you can assign a 
drum map to any MIDI track – this gives you the same drum editing 
features as in previous Cubase versions.

Where’s the MIDI Track Mixer?

Mixing MIDI is done in the Track Mixer together with your audio chan-
nels. The MIDI channel strips are similar to the channel strips in the MIDI 
Track Mixer, allowing you to set levels, panning and other parameters 
for your MIDI tracks.
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New features in Cubase SX/SL

Here follows a brief outline of the main new features in Cubase SX/SL:

Multiple Undo/Redo

Cubase SX/SL offers wide-ranging, multiple Undo, allowing you to 
undo virtually any action you perform. See page 174.

Edit History

The Edit History dialog allows you to undo or redo several actions in 
one go. This is described on page 175.

Offline Process History

The Offline Process History allows you to remove and modify applied 
processing, and is different from the “regular” Undo in that you don’t 
have to undo processing functions in the order they were performed. 

The Offline Process History is described in the chapter “Audio pro-
cessing and functions” in the Operation Manual.

Graphic editing of automation events

Automation handling is greatly improved in Cubase SX/SL. Automa-
tion events can be drawn graphically in the Project window. Each au-
dio and MIDI track in the Track list has an automation track containing 
all parameters for the track. You can select which parameters to view 
and edit by opening subtracks for the automation track. 

• You can of course also use normal “Write/Read” automation to record 
your actions just like in previous versions of Cubase. 

• All effect control panels also feature Write/Read buttons.
Each automated effect and VST Instrument will have its own automation track in the 
Track list, with subtracks for each parameter.

See the chapter “Automation” in the Operation Manual.
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Surround sound (SX only)

Cubase SX has integrated surround sound features with support for 
several formats. See the Operation Manual chapter “Surround sound” 
for descriptions.

Integration 

The new graphic design in Cubase SX/SL integrates the various win-
dows in a much clearer way than before. For example, the Inspector, 
the Track list and the Track Mixer have many shared parameters, which 
all have the same style buttons. This allows you to make settings quickly 
and intuitively in whatever window you are currently working with. 

Hitpoints

Hitpoint editing is a special feature of the Sample Editor. It allows you 
to create “slices” for drum or other rhythmic loops. A sliced loop can 
adapt to tempo changes without affecting pitch, amongst other things. 
This is described in the chapter “Working with hitpoints and slices” in 
the Operation Manual.

The previous system of tempo/time-based hitpoints for matching time 
and meter positions is no longer used.

VST System Link

VST System Link is a system for networking computers using VST 
software and ASIO hardware. This allows you to work with multiple 
computers (even cross-platform), and to dedicate certain tasks to dif-
ferent computers. You can run all VST Instruments on one computer, 
all audio tracks on another etc. See the Operation Manual chapter 
“VST System Link” for more info.
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About this chapter

This chapter contains a step-by-step description of how to make a sim-
ple audio recording and play it back. The purpose is for you to try out 
some of the most common recording and playback features. However, 
you should make sure to read the Recording chapter in the Operation 
Manual before doing any “serious” recording, as there are a lot of set-
tings, options and methods that are not mentioned here.

Before you start

This chapter assumes the following:

• You have installed and set up your audio hardware.

• Your audio source (a mixer or tape recorder, for example) is properly 
connected to the inputs of the audio hardware.

• The outputs of the audio hardware are connected to some sort of lis-
tening equipment, allowing you to listen to the recorded audio during 
playback.

• You are monitoring your audio source externally. 
That is, when you are recording, you listen to the audio source before it goes into 
Cubase SX/SL. A typical setup would be to have an audio source connected to an ex-
ternal mixer, and feed the signal into Cubase SX/SL via an auxiliary bus or send, while 
listening to the output of the mixer. 
Note that this is just to make things simple in this chapter – there are various ways to 
monitor the signal through Cubase SX/SL, as described in the Recording chapter in the 
Operation Manual.

• You have launched Cubase SX/SL.
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Creating a new project

Before you can start recording, you need a working environment – 
a project:

1. Pull down the File menu and select “New Project”.
A dialog appears, listing a number of project templates for various purposes.

2. Make sure the “Empty” item in the list is selected and click OK.
A file dialog appears, allowing you to specify a location for the project folder. This will 
contain all files related to the project. 

3. Navigate to the desired location of the project folder, and select it by 
clicking OK, or click “Create” to create and name a new folder.
The project folder is created on disk, and an empty Project window appears.

At this point, you can make various settings for the project, such as 
sample rate, resolution, etc. However, to keep things simple we will 
use the default settings for now. 
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The next step is to create an audio track to record on:

4. Pull down the Project menu and select “Add Track”.
A submenu appears, listing the various types of tracks available in Cubase SX/SL.

5. Select “Audio”.
An empty audio track appears in the Project window.
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Preparing to record

Before you can start recording, there are some preparations to make:

Selecting stereo or mono

You need to decide whether you want the recording to be in stereo or 
mono. This is done by clicking the Stereo/Mono switch in the area to 
the left of the audio track.

• In this example, set the track to stereo by clicking the button so that it 
lights up and shows a double circle.

Activating and routing inputs

1. Pull down the Devices menu and select “VST Inputs”.
The VST Inputs window appears. This lists all audio inputs on your audio hardware, al-
lowing you to turn inputs on or off.

2. Locate the input pair to which you have connected your audio source, 
and make sure its “On” button in the Active column is lit.
If not, click the button to turn the input on.
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3. Close the VST Inputs window, and open the Mixer from the Devices 
menu.
This is Cubase SX/SL’s mixer window, used for setting levels, etc. The Mixer contains 
an channel strip for each audio, MIDI and group track in the Project window, so cur-
rently there will be a single stereo audio channel strip.

4. Pull down the Input pop-up menu at the top of the channel strip.
This is where you select which audio input should be routed to the audio channel for 
recording.

5. Select the input pair to which you have connected your audio source.
Your audio source is now routed to the audio channel, so that it can be recorded on 
the audio track.

Leave the Mixer window open for now.
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Checking the input level

To avoid clipping, you need to check the input level before recording:

1. Click the “Record Enable” button next to the fader on the Mixer chan-
nel strip.
When the Record Enable button is lit, the level meter will show the input level (as op-
posed to the level of the playback signal). 

Record enabling the track can be done in the Mixer (left) or in the Track list.

2. Activate your audio source.
You will see the level meters reacting.

3. Adjust the output level of your audio source so that the meters go as 
high as possible without going up to 0.0 dB.
Check the numerical peak level indicator above the meter in the channel strip.
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Making the track ready for recording

1. Make sure the Transport panel is visible.
If not, pull down the Transport menu and select the “Transport Panel” item at the top.

The Transport panel

2. Make sure the buttons on the Transport panel are set up like this:

If any of these buttons are lit, click on them to deactivate them.

3. Click in the ruler (the time scale area above the track in the Project 
window), at the position where you want to start recording.
When you click, the project cursor (the black vertical line) is automatically moved to 
the click position. In our example, recording will start from the project cursor position.

Setting the project cursor position in the ruler.

4. To set recording to start at the cursor position, pull down the Trans-
port menu and make sure the item “Start Record at Left Locator” is 
deactivated (unticked).

You are ready to record!
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Recording

1. Start recording by clicking the Record button on the Transport panel.
The project cursor will start moving.

2. Play your instrument, etc.
During recording, a rectangle will appear, covering the recorded area. This is the re-
corded audio event.

3. When you are done, click the Stop button on the Transport panel.
Recording stops. Cubase SX/SL will calculate a waveform image of your recording 
and display it in the audio event.

4. If you are done with recording, click the Record Enable button in the 
area to the left of the track, so that it goes dark.

Playing back what you just recorded

1. Move the project cursor to the beginning of the recorded audio event.
This could either be done by clicking in the ruler, or by using the Rewind button on the 
Transport panel.

2. Click the Play button on the Transport panel.
Your recording will be played back.

3. When you are done, stop playback by clicking the Stop button on the 
Transport panel.
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Recording more events
At this point, you may want to continue recording audio, on the same track or on a new 
track.

Recording more on the same track

To record more audio on the same track, move the project cursor to a 
new start position and proceed as when you recorded the first time.

❐ It is possible to record audio events that overlap each other, but only the 
visible events (the events at the top) will be heard when you play back.

Recording a new audio track

This example shows how to record a new audio track, while listening 
to the first recording.

1. Create a new audio track by using the “Add Track” submenu on the 
Project menu.

2. Decide whether you want the new track to be stereo or mono by using 
the Stereo/Mono switch in the area to the left of the track.

3. Pull down the Devices menu and open the Mixer.
As you can see, a new channel strip has been added to the Mixer.

4. Use the Input pop-up menu at the top of the channel strip to make 
sure that the correct audio input is selected for the new track.
If the audio source is another than the one you first recorded, you need to check the in-
put level again – see page 79.

5. In the Project window, record enable the new track by clicking its 
Record Enable button.
Make sure that the Record Enable button for the first track is disabled – otherwise you 
will be recording on both tracks at the same time.

6. Move the project cursor to the desired start position.

7. Activate recording by clicking the Record button on the Transport panel.
While you are recording, the first audio track is played back.

8. When you are done, click the Stop button on the Transport panel.
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Playing back in a cycle

You could continue starting and stopping playback this way, moving 
the project cursor manually each time. However, if you want to try out 
some mixing features (see the “Mixing” chapter), it is more practical to 
have Cubase SX/SL play back your recorded audio repeatedly, over 
and over again:

1. Click on the recorded audio event to make sure it is selected.
A selected audio event has a red border and white and blue handles at its beginning 
and end.

2. Pull down the Transport menu and select “Locators to Selection”.
This moves the left and right locator (two special Cubase SX/SL markers) to the begin-
ning and end of the selected audio event, respectively. In the ruler, the area between 
the left and right locator is indicated by a green line.

3. Click the Cycle button on the Transport panel so that it lights up.

4. Move the project cursor to the beginning of the recording and click 
Play.
Playback starts. When the project cursor reaches the end of the recording (the right 
locator), it will immediately jump back to the left locator and continue playback. When 
you’re done, click the Stop button on the Transport panel.
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About this chapter

This chapter describes the basic operations for recording and playing 
back MIDI. For a full description of MIDI recording please see the 
chapter “Recording” in the Operation Manual. 

Before you start

This chapter assumes that you have correctly connected your MIDI 
equipment according to the instructions in the chapter “Setting up 
your system” in this book. 

This tutorial connects to the previous chapter, so if you followed the 
instructions there, you should now have recorded two audio tracks.

About MIDI Thru

The normal way to work with MIDI is to have MIDI Thru activated in 
Cubase SX/SL, and Local Off selected in your MIDI instrument(s). In 
this mode, everything you play during recording will be “echoed” back 
out again on the MIDI output and channel selected for the recording 
track. 

1. Open the Preferences dialog and select the MIDI page.
The Preferences dialog is located on the File menu under Windows and on the 
Cubase SX/SL menu under Mac OS X.

2. Make sure the option “MIDI Thru Active” is activated, and then follow 
the steps below.
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Setting up for recording MIDI

Creating a MIDI track

To create a MIDI track, proceed as follows:

1. Pull down the Project menu, and select “Add Track”.
A submenu appears.

2. Select MIDI from the submenu.
A MIDI track is added to the Track list.

Setting the MIDI input 

1. To set the MIDI input for a track, pull down the “in:” pop-up in the 
Inspector and select an input.
The available MIDI inputs are shown. The items on the menu depend on the type of MIDI 
interface you are using etc. You can set the MIDI input independently for each track.

Click here to set the MIDI input.
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2. Record enable the MIDI track by clicking the corresponding button in 
the Track list.
MIDI Thru is automatically activated when the track is record enabled.

Record enabling the track in the Track list. This can also be set in the 
Inspector area to the left.

3. Play a few notes on your MIDI instrument, and check the level meter in 
the Track list to make sure that the MIDI signal is received.
If not, check that you have correctly set up your MIDI system, as described on page 41.
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Setting the MIDI output and channel

1. To set the MIDI output for a track, pull down the “out:” pop-up in the 
Inspector and select the output to which you have connected your 
MIDI device.
The available MIDI outputs are shown. The items on the menu depend on what type of 
MIDI interface you are using etc. 

Click here to set the MIDI output.

2. To set the MIDI channel for a track, use the MIDI “chn:” pop-up in the 
Inspector.
If you set the track to MIDI channel “ANY”, it will transmit MIDI on the channel(s) used 
by the MIDI input device (the MIDI instrument you play during recording). 

Click here to set the MIDI channel.
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Selecting a sound

• To select different sounds, you can send Program Change messages 
to your MIDI device using the “prg:” value field in the Inspector.

Click here to select a Program number.

Program Change messages give access to 128 program locations. If 
your MIDI instruments have more than 128 programs, Bank Select 
messages (set in the “bnk:” value field) allow you to select different 
banks, each containing a number of programs.

• Play a few notes on your MIDI instrument to check that the selected 
sound program is correct.
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Recording MIDI 

1. Make sure the track is record enabled and correctly set up, as de-
scribed in the previous section.

2. Make sure that Cycle and Punch In/Out is deactivated on the Trans-
port panel.

3. To set recording to start at the cursor position, pull down the Trans-
port menu and make sure the item “Start Record at Left Locator” is 
deactivated (unticked).

4. Place the project cursor at the position where you wish to begin re-
cording.
For example, you could try recording a MIDI part together with the audio tracks that 
you recorded in the previous tutorial.

5. Activate Record on the Transport panel, and play a few notes on your 
MIDI instrument.
When you finish recording, a MIDI part containing MIDI events is created in the 
Project window. 

6. If you are done with recording, click the record enable button in the 
area to the left of the track, so that it goes dark.

Playing back what you just recorded

1. Move the project cursor to the beginning of the recorded MIDI part.
This could either be done by clicking in the ruler, or by using the Rewind button on the 
Transport panel.

2. Click the Play button on the Transport panel.
Your recording will be played back.

3. When you are done, stop playback by clicking the Stop button on the 
Transport panel.
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Playing back in a cycle

You could continue starting and stopping playback this way, moving 
the project cursor manually each time. However, it is more practical to 
have Cubase SX/SL play back your recorded parts and events re-
peatedly, over and over again:

1. Click on the recorded MIDI part to make sure it is selected.
A selected MIDI part has a red border and white handles at its beginning and end.

2. Pull down the Transport menu and select “Locators to Selection”.
This moves the left and right locator (two special Cubase SX/SL markers) to the begin-
ning and end of the selected MIDI part, respectively. In the ruler, the area between the 
left and right locator is indicated by a blue line.

3. Click the Cycle button on the Transport panel so that it lights up.

4. Move the project cursor to the beginning of the recorded part and 
click Play.
Playback starts. When the project cursor reaches the end of the recording (the right 
locator), it will immediately jump back to the left locator and continue playback. When 
you’re done, click the Stop button on the Transport panel.
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Transposing the MIDI track

Let’s try transposing the MIDI track, using Track Parameters in the 
Inspector:

1. Make sure that the Inspector button on the toolbar is lit.

2. Select the MIDI track by clicking on it in the Track list.
The parameters for the MIDI track is now shown in the Inspector area to the left.
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3. Click on the Track Parameters tab in the Inspector.

Click here...

...to open the Track Parameter settings in the Inspector.
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4. Click on the blue value line in the Transpose field in the Inspector.
A fader appears, allowing you to transpose the MIDI part up or down in semitones. You 
can also use the up/down arrows to the right in the value field to set transpose values.

Click here...

...to set a transpose value for the MIDI part.

5. Start playback to hear the transposed MIDI part.
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About this chapter

This chapter contains basic descriptions of the Mixer, and how to use 
the effects and automation in Cubase SX/SL. The purpose is to intro-
duce the basic elements involved when mixing audio and MIDI. How-
ever, for complete descriptions of these three areas, you should refer to 
the chapters “The Mixer”, “Audio Effects” and “Automation” in the Op-
eration Manual, as there are a lot of settings, options and methods that 
are not mentioned here. 

Before you start

❐ Although MIDI tracks are also shown in the Mixer, and the basic mixer 
operations such as setting level and pan, using mute and solo and auto-
mation etc. are the same for both audio and MIDI channel strips, you 
should refer to the Operation Manual chapter The Mixer for descriptions 
of MIDI mixing specifics.

• This chapter is a continuation of the previous two tutorials, so it is as-
sumed that you have recorded events on two audio tracks, and a MIDI 
part.
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Opening the Mixer

To open the Mixer, select it from the Devices menu.

The Mixer with two audio channels and one MIDI channel strip. To the right is the 
Master gain fader.

The Mixer window is similar in appearance to a conventional hardware 
mixer, with a level fader for each audio and MIDI channel strip. The 
Mixer will contain the same number of channels as the number of audio 
and MIDI tracks present in the current project. Beside each channel’s 
level fader, there is a level meter which indicates the signal level of au-
dio events on the corresponding audio track during playback. For MIDI 
tracks, the meters show velocity levels, not signal level.
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Setting the level
1. With the Mixer window still open, activate Cycle playback (see previ-

ous tutorials).
Make sure that you have a Mixer channel playing back a signal in view.

2. Click on the level fader handle and drag down or up.
You will hear the volume of the playback signal being changed. The meters will also re-
flect the change of level for audio tracks. As MIDI channel strip meters indicate velocity 
levels of the MIDI events on the track, the meters will not change if you pull down the 
fader, but the volume will.

Setting pan

Pan sets the left/right position in the stereo field.

• Click on the blue line in the Pan control box above the fader, and drag 
to the left or right.
You will hear the stereo balance being changed.

Adjusting pan for one of the audio channels.
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Using Mute and Solo

Each audio and MIDI channel strip has a Mute and a Solo button, al-
lowing you to silence one or several channels. The following applies:

• The Mute button silences the selected channel.
Several channels can be muted simultaneously. A muted channel is indicated by a lit 
Mute button. To unmute a muted channel, click the Mute button again.

• The Solo button mutes all other channels, so you only hear the se-
lected channel.
A soloed channel is indicated by a lit Solo button. Several channels at a time can be 
soloed. To unsolo a soloed channel, click the Solo button again.
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Adding EQ to an audio channel

The Mixer parameters differ between audio and MIDI channels. EQ, 
for example, is not available for MIDI channel strips.

Equalization shapes the tone of a signal by boosting and/or cutting se-
lected frequencies. To add EQ to an audio channel, proceed as follows:

1. Click the Edit button for the channel you wish to apply EQ to.

Clicking this button...

...opens the Channel Settings window, with the EQ section in the middle.
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2. Activate as many EQ modules as you need (up to four) by clicking the 
On/Off buttons.
As soon as any of the EQ modules are activated, the “EQ” button indicator in the chan-
nel strip is lit, and there will be a point added in the EQ curve display for each activated 
module.

Activating EQ modules.

3. You can set the parameters for the activated EQ module(s) by using 
the knobs, by dragging points in the display or by entering numerical 
values.
See the Operation Manual chapter “The Mixer” for more details.

• You can also apply EQ in the extended channel strip (SX only).
This is also described in the Operation Manual chapter “The Mixer”.

EQ modules in the extended channel strip.
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Adding audio effects

Send effects

When you use send effects, audio is routed through the effect proces-
sors via independent effect sends for each channel, just like on a “real” 
physical mixer.

Adding a Send effect

1. Pull down the Devices menu and select “VST Send Effects”.
An “effect rack” window appears, with eight slots, all empty.

2. Click in the black field for the effect slot at the top (in the area that 
says “No Effect”).
A pop-up menu appears, listing all available effect plug-ins. The effects are organized 
in subfolders according to the effect type.
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3. Select “DoubleDelay” in the “Delay” subfolder.
The effect is loaded into the first effect slot. The lit on button indicates that the effect is 
activated, and the effects control panel is opened.

• You can make settings for the effect later by clicking the “E” button, 
but for now we will just use the default settings so you can close the 
control panel.
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Activating Sends

Sends can be set up in Channel Settings window.

1. Click the Edit button for the channel you wish to apply a Send effect to.
The Channel Settings window opens with the Send section on the right side.

The Send section in the Channel Settings window.

2. Click in the “No Effect” field and select “DoubleDelay” from the pop-
up menu that appears.
The send is now activated, as indicated by the lit power button.

3. Start playback and drag the value slider to the right.
You will hear the effect being added to the channel being played back.

• Sends can also be displayed in the extended channel strip (SX only).
This is described in the Operation Manual chapter “The Mixer”.
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Automating a fader

Virtually every Mixer and effect parameter can be automated. Each 
channel has an automation track which is hidden by default. When you 
use Write automation the automation events that are generated are re-
corded on the corresponding channel’s automation track. These events 
can be viewed and edited on automation “subtracks”, one for each 
channel parameter that has been automated. Automation subtrack edit-
ing is described in the chapter “Automation” in the Operation Manual.

In the following section, we will go through the steps of automating a 
fader in the Mixer using Write/Read automation.

About Write/Read automation

There are separate Write (W) and Read (R) buttons for each channel 
in the Mixer.

The Write (W) and Read (R) buttons for a channel in the Mixer.

• If you activate Write for a channel, all mixer parameters you adjust during play-
back for that specific channel will be recorded.

• If you activate Read for a channel, all your recorded mixer actions for that 
channel will be performed during playback, just like you performed them in 
Write mode.
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There are also global Read/Write buttons in the Mixer’s Common 
panel, the leftmost panel in the Mixer. 

• When Write All is activated, all Mixer actions you perform during playback (for 
all channels) will be recorded as Automation Events.

• When Read All is activated, all your recorded mixer actions for all channels 
will be performed during playback.

An example

For a quick step by step description of how to use Write/Read auto-
mation to automate a fader, proceed as follows:

1. Activate Write automation for a channel by clicking the “W” (Write) 
button.
The button lights up.

2. Start playback.

3. Move the channel fader up or down.

4. Click Stop on the Transport panel, and go back to the position where 
you activated playback.

5. Click on the Write button to deactivate Write mode.

6. Click on the Read button so that it lights up.
Read mode is now activated.

7. Start playback.
The Volume fader will now mirror the actions performed while in Write mode.

• To redo anything that was recorded, activate Write mode again, and 
start playback from the same position.

• You may have Write and Read activated simultaneously, if you want to 
watch and listen to your recorded mixer actions while you’re recording 
fader movements for another mixer channel, etc.
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About this tutorial

This tutorial describes some of the procedures for editing in the Project 
window. Typically, this is where you do the “large-scale” editing and re-
arranging of events. Again, please note that this tutorial only describes 
some of the many functions in the Project window – for details and full 
descriptions, see the Operation Manual.

Preparations

This tutorial is based on an existing file, included on the Cubase SX/SL 
CD. If you have followed the previous chapters, you will have a project 
open with some recorded audio and MIDI material. You can either close 
that project or keep it open in the background – it doesn’t matter.

1. Insert the Cubase SX/SL CD and open it for browsing.

2. On the CD, open the “Demo Projects” folder and locate the folder 
“SX Tutorial” (Cubase SX) or “SL Tutorial” (Cubase SL).

3. Copy this folder to the computer’s hard drive (for example in the “My 
Documents” folder).

4. Open the copied folder and double click on the file “Tutorial 4.cpr”.
Note: Whether the file name extension is shown or not under Windows depends on 
your computer settings.

Now the “Tutorial 4” project opens in Cubase SX/SL.

• If you had another project open, make sure the Tutorial 4 project is at the 
front and click the Activate button in the upper left corner of the Project 
window so that it is lit (red).
This indicates which project is active when you have several projects open.
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Overview

As you can see, this project contains four audio tracks (drums, bass, 
guitar and strings) with a few events. Try playing back the project from 
the beginning!

Well, it’s obvious that things are pretty disorganized here; the audio 
events do not fit together very well. The goal of this tutorial is to make 
some sense out of this, by editing in the Project window.

❐ While this tutorial describes editing audio events, most of these proce-
dures can also be used for editing MIDI parts in the Project window. See 
the Operation Manual for details.
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Moving and copying events

Let’s start by making the events start at the same time:

1. Select the Arrow tool by clicking its icon in the toolbar.

2. Make sure the Snap button is activated and the Grid option is selected 
on the Snap pop-up menu:

Snap helps you find the correct positions when moving and editing, by 
making objects “magnetic” to certain positions (or to other objects). 
When the Grid option is selected and the Grid pop-up menu to the 
right is set to “Bar” as in the figure above, you can only move objects 
to the start of bars.

3. Click on the first Bass Synth event, and drag it all the way to the left.
Now it will start at the same time as the “Slow Disco” drum event.

4. Drag the next Bass Synth event so that it starts where the first one 
ends.

5. In the same way, drag the Guitar event and the Strings event so that 
they start at the beginning too.

6. Move the project cursor to the start of the project and play back.

The Snap button
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OK, that’s much better, but there are still things to fix. For example, the 
Wah guitar event ends after one bar, while the other events last two 
bars. Let’s add a copy of the guitar event:

7. Press [Alt]/[Option], click the Wah guitar event and drag it one bar to 
the right.
A copy of the event is created.

As you can see, the names of the Wah guitar events are shown in italics. This 
indicates that these are shared copies – they use the same audio clip.

So now we have a two-bar, slightly cheezy disco pattern. Now we 
could just activate Cycle playback and listen to these two bars over 
and over again. Instead we’ll use the Repeat function:

8. Select all events by pressing [Ctrl]/[Command]-[A] on the computer 
keyboard.
This is the same as using the Select All function on the Edit menu. You can also select 
multiple events by [Shift]-clicking each event in turn or by dragging a selection rectan-
gle around them with the Arrow tool.

9. Pull down the Edit menu and select “Repeat…”.
A dialog appears.

10.Set the “Count” parameter to 3 and click OK.
All events are repeated three times, for a total of four two-bar patterns. This is just the 
same as copying by [Alt]/[Option]-dragging, but much quicker, especially if you need 
several copies after each other.

At this point, our song is eight bars long. It could use some variation!
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Muting and erasing events

A quick way of adding variation is to remove stuff. We could for exam-
ple let the different instruments appear gradually instead of all at the 
same time:

1. Select the Mute tool from the toolbar.

2. Click on the first two Bass Synth events, and then on the first two Hi 
Strings events.
They are “greyed out” indicating that they’re muted.

3. Start playback from the beginning.
Fine, now the bass appears at bar 3 and the strings at bar 5.

The Mute tool is very useful for trying out variations, etc. However, now 
that we’re sure that we want to remove those events, we might as well 
delete them for real:

4. Select the Eraser tool from the toolbar.

5. Click on the four muted events.
They are removed.

6. While you’re at it, remove the two first Wah guitar events too.
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Splitting and resizing events

Well, maybe that wasn’t such a good idea after all – it may have been 
better with some guitar from the beginning, but maybe with some vari-
ation. Here’s an idea:

1. Pull down the Edit menu and select Undo.
The last deleted guitar event reappears.

2. Select Undo again.
The first guitar event appears. 

Cubase SX/SL has unlimited undo – you could go back all the way to 
the start of this tutorial by undoing your actions, if needed. However, 
we will only need one guitar event for this:

3. Select Redo from the Edit menu.
The first guitar event is removed again.

4. Select the Scissors tool from the toolbar.

Now, the idea is to split the Wah guitar event into smaller sections, to 
vary them. However, currently you can only make edits at whole bar 
positions because the Snap Grid is set to “Bar”.

5. Pull down the Grid pop-up menu on the toolbar and select “Beat”.
Now you will be able to split or position events at each beat (quarter note) position.
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6. Click with the Scissors tool at fourth beat in the Wah guitar event (at 
the beat just before the start of bar 3).
The event is split in two; one three beat long and another one beat long. If you were to 
play back this section now, you wouldn’t hear any difference, though.

7. Select the Arrow tool again.

8. Drag the first guitar event two beats to the left and play back.
Not too bad, but we could use a little more guitar in the second bar:

9. Position the pointer in the lower left corner of the second guitar event 
(the one bar long event).
The pointer is shown as a double arrow, indicating that you can resize the event by 
dragging.

10.Click and drag one beat to the left.
What you did was to resize the event. In effect, you make the event start playing earlier 
in the audio clip. Events could be viewed as “windows” looking into an audio clip – by 
resizing an event you get to see more or less of its clip.

OK, that brought some variation to the start of the “song”.



CUBASE SX/SL
Tutorial 4: Editing in the Project window 10 – 117

Adding a fade

The strings in bar 5 appear rather abrupt – they would benefit from 
being faded in:

1. Click on the first Hi Strings event with the Arrow tool.
The event is selected. The blue handles at the top are fade and volume handles.

2. Click at the upper left handle and drag it to the right.
A thin blue line indicates the fade-in.

3. Play back to hear the fade.
You can adjust the length of the fade by dragging the handle. 

It’s not bad, but it would be even better if the fade-in was slower at the 
beginning and quicker at the end (i.e. more exponential).

4. To change the shape of the fade, double click on the fade line.
This opens a dialog in which you can adjust the fade settings:

5. Click one of the buttons to the right below the curve display to get a 
more exponential fade curve.
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6. Click OK to close the dialog and play back the section again.

Now we would want the same fade to be applied to the second string 
event. While we could repeat the settings manually, it’s probably eas-
iest to copy the faded event:

7. Remove the second string event by clicking it with the Eraser tool.

8. Press [Alt]/[Option] and drag the first string event two bars to the 
right.
As you can see, the copied event retains the fade you created.

That concludes this tutorial! 

Now you’ve tried some of the many editing features in Cubase SX/SL’s 
Project window. If you like, you could use your new skills to change the 
end of the eight-bar “song”, which ends rather abruptly now. For exam-
ple, you could apply fade-outs, resize events to make the different instru-
ments end one by one, or create more copies to make the song longer. 
Or, you can move on to the next chapter, in which we’ll take a look at 
VST Instruments.
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About this tutorial

This tutorial shows you how to set up and use VST Instruments – soft-
ware synthesizers (or other sound sources) that are contained within 
Cubase SX/SL. For detailed descriptions of procedures and the pa-
rameters of the included VST Instruments, see the Operation Manual.

Preparations

Just like the previous chapter, this tutorial is based on an existing file, 
included on the Cubase SX/SL CD.

• Below, we assume that you have followed the previous tutorial and cop-
ied the “SX Tutorial” or “SL Tutorial” folder to your hard drive.
If not, please see page 110.

1. Close any open projects, by making their Project windows active and 
selecting “Close” from the File menu.
This is just to make things clear and avoid confusion – you can have several projects 
open in Cubase SX/SL if needed.

2. Pull down the File menu and select Open.

3. In the file dialog that appears, navigate to the “SX Tutorial” or “SL Tu-
torial” folder on your hard drive, select the file “Tutorial 5.cpr” and click 
Open.

• At this point, a dialog may appear asking you to resolve missing MIDI 
outputs.
This is because you probably don’t have the same MIDI output configuration as the 
creator of this project had. However, just click OK to close this dialog for now.
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The “Tutorial 5” project opens. If you followed the previous tutorial, 
this will look oddly familiar... It’s the same eight-bar “song” that you 
created in tutorial 4, but with three extra tracks.

Activating a VST Instrument

The three tracks at the bottom of the track list are MIDI tracks, as indi-
cated by the MIDI connector symbol in the track list. As you can see, 
one of the tracks is called “MIDI Bass” – our first goal in this tutorial is 
to replace the “Bass” audio track with a bass sound from a VST In-
strument.

1. Pull down the Devices menu and select VST Instruments.
The “rack” that appears can contain up to 32 VST Instruments (Cubase SX only - Cu-
base SL is limited to 8 slots). However, the maximum number of instruments depends 
on your computer performance and the complexity of the instruments.

2. Click in the first VST Instrument slot.
A pop-up menu appears, listing the included VST Instruments.
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3. Select “vb-1”.
The VB-1 virtual bass unit is loaded.

4. Make sure the “power button” to the left in the slot is activated (lit).

5. If you like, click the Edit (“e”) button in the slot to bring up the control 
panel for the instrument.
Since we cannot hear the instrument yet, there’s not much point in making settings 
though.

You can keep the control panel open or close it – it doesn’t matter, as long as the 
VST Instrument is activated (power button is lit).

OK, so now we have activated a VST Instrument. Now you need to 
route a MIDI track to the instrument.
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Routing

1. Go back to the Project window and select the “MIDI Bass” track by 
clicking in the Track list.

2. Make sure the Inspector is open.
The Inspector is the area to the left of the Track list. If it’s not visible, click the Show 
Inspector button on the toolbar:

3. Make sure the top section of the Inspector is shown.
If not, click on the tab in the upper right corner of the Inspector:

The Inspector shows the settings for the selected track – in this case, 
the MIDI Bass track.

4. Pull down the “out:” pop-up menu in the Inspector.
This shows all available MIDI outputs, including any MIDI interfaces you have installed, 
any audio card-based synthesizers in your computer and all activated VST Instruments.

5. Select the VB-1 from the pop-up menu.
The track is now routed to the VB-1. This VST Instrument receives MIDI on any channel, 
so you don’t have to care about the MIDI channel setting. However, some VST Instru-
ments are multitimbral and can receive different MIDI data on several different channels 
– if that had been the case you would have had to set the chn setting properly.
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Playing back

Now it’s time to replace the audio bass with the VB-1:

1. Click the Mute (“X”) button in the Track list for the “Bass” track.
This mutes (silences) the track.

2. Click the lit Mute button in the Track list for the “MIDI Bass” track so 
that it goes dark.
You have now unmuted the MIDI Bass track.

3. Start playback from the beginning of the song.

You should now hear the VB-1 play the bass line. You may have to ad-
just the volume so that the VST Instrument matches the audio tracks:

4. Pull down the Devices menu and select Track Mixer.
The Mixer window appears. As you can see, there are separate mixer channel strips for 
the four audio tracks, the three MIDI tracks and the VB-1.

The mixer channel strip for the VST Instrument.

5. Use the volume fader in the VB-1 channel strip to adjust the level of 
the bass line.
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Adding another instrument

The next MIDI track is called “MIDI Perc” and contains a MIDI percus-
sion pattern. This is an excellent opportunity to check out another of 
the included VST Instruments – the LM-7 drum machine:

1. Open the VST Instruments window from the Devices menu.

2. Pull down the pop-up menu for the next slot and select “lm-7”.
Make sure its On button is activated.

3. In the Project window, click the Mute (“X”) button for the MIDI Perc 
track so that it goes dark.

4. Select the track by clicking in the Track list.

5. Use the “out:” pop-up menu in the Inspector to route the track to the 
LM-7.
As soon as you activate a new VST Instrument, it is added to the list of available MIDI 
outputs in Cubase SX/SL.

Now, let’s listen to the percussion track all by itself:

6. Click the Solo (“S”) button in the Track list for the MIDI Perc track.
All other tracks are muted (their Mute buttons light up).

7. Start playback.
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Hmmm, nothing can be heard – but the indicator in the Track list shows 
that MIDI notes are being played! The problem here is that the wrong 
program (drum set) is selected for the LM-7. For this track to play back 
properly, we should choose a percussion set. This could be done di-
rectly in the Inspector or the VST Instruments window, but let’s check 
out the control panel for the LM-7 instead:

8. Click the Edit (“e”) button for the track in the Inspector (near the upper 
right corner).
Since the track is routed to a VST Instrument, this opens the control panel for the in-
strument. This way, you don’t have to go via the VST Instruments window to make set-
tings for a VST Instrument.

The LM-7 panel. The labels underneath the buttons show the available sounds in 
the selected program – not many percussion sounds here.

9. Pull down the program pop-up menu in the control panel and select 
“Percussion”.
Under Windows, you will find this pop-up menu at the top of the panel; under Mac OS 
X it is at the bottom of the panel.

10.Start playback again.
That’s more like it.
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11.Go back to the Project window and click the lit Solo button for the 
track to turn off the Solo function.
All tracks are unmuted again – except the tracks that were muted from the beginning 
(Bass and MIDI Strings).

Again, you may want to adjust the volume of the LM-7. If you open the 
Track Mixer, you will find that a new channel strip has appeared – use 
the fader as before.

Playing a VST Instrument in real time

The next part of this tutorial requires two things:

• That you have a MIDI keyboard or similar connected to a MIDI input on 
your MIDI interface.

• That you are using audio hardware with fairly low latency (see page 46).
If the latency is too big, it will be almost pointless to try to play a VST Instrument in real 
time – the delay between when you press a key and when you hear the sound will be 
too large. If you’re uncertain about your latency, just proceed with the steps below – 
you’ll find out whether it’s OK or not.

Now we’ll make use of the third included VST Instrument: the a1 syn-
thesizer. Here, we will use it with a string sound (replacing the “Strings” 
audio track) but you can of course choose another sound if you like.

1. Open the VST Instruments window from the Devices menu.

2. Pull down the pop-up menu for the third VST Instrument slot and select 
“a1”.
Make sure its power button is activated.

3. In the Project window, mute the “Strings” track and unmute the “MIDI 
Strings” track, by clicking their respective Mute buttons in the Track list.

4. Select the MIDI Strings track.

5. In the Inspector, pull down the “out:” pop-up menu and select “a1”.
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This routes the track to the a1 synthesizer. However, now we also 
need a MIDI input, since you’re going to play the VST instrument “live”:

6. Pull down the “in:” pop-up menu and make sure the correct MIDI input 
is selected.
This should be the MIDI input to which your keyboard (or other controller) is connected. 
If in doubt, you can select the “All MIDI Inputs” option, in which case the track will ac-
cept MIDI from all available inputs.

7. Click the monitor button in the Track list for the MIDI Strings track, so 
that it lights up.
When the monitor button is activated, incoming MIDI is sent directly to the selected 
output – in this case the a1 synthesizer.

8. Try playing your MIDI keyboard.
You should hear the sound from the a1. However, you may not want to use the default, 
first sound:

9. Use the pop-up menu below the “chn:” setting in the Inspector to 
select a suitable synth sound.
Since we’re supposed to replace the Strings part, you may for example want to try the 
“Solina WMF” patch (under the PAD heading).

10.Start playback and play along!
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Recording

When you’ve figured out something to play, it’s time to record this. Re-
cording for a VST Instrument is done just like “normal” MIDI recording:

1. Click the record enable button for the MIDI Strings track.

2. Pull down the Transport menu and make sure the “Start Record at 
Left Locator” setting is turned off.
When this is turned off, recording will start at the current project cursor position, which 
is probably the easiest method at this point.

3. Move the project cursor to where you want the recording to start.

4. Click the Record button on the Transport panel to start recording.

5. Play along with the background tracks.

6. When you’re done, click Stop.
A MIDI part has been created on the MIDI Strings track.

7. Play back to listen to your recording.
If you want to try again, select Undo from the Edit menu and proceed from step 3 above.

8. When you’re done, click the record enable button for the track to de-
activate it.
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Making parameter settings

After you’ve recorded your synth or string part (and possibly adjusted 
its volume in the Mixer) you may want to adjust the actual sound as well. 
This can either be done by selecting another patch in the Inspector or 
VST Instruments window, or by using the synth parameters in the con-
trol panel for the a1.
First, you may want to set things up so that the whole piece plays 
back over and over again.

1. In the Project window, press [Ctrl]/[Command]-[A] to select all events 
and parts.

2. Pull down the Transport menu and select “Locators to Selection”.
This moves the left locator to the start of the first event and the right locator to end of 
the last.

3. Make sure Cycle is activated on the Transport panel, and start playback.
The whole “song” will now play back repeatedly.

Cycle activated on the Transport panel.

4. Click the Edit (“e”) button in the Inspector for the MIDI Strings track, 
to bring up the a1 control panel.

5. While the music is playing, try adjusting the parameters by clicking 
and dragging the controls in the panel.
The a1 is laid out much like a traditional analog synthesizer. You may for example want 
to adjust the Cutoff and Resonance settings in the Filter section.
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Automating the changes

Just like other Track Mixer and effect settings in Cubase SX/SL, pa-
rameter changes for VST Instruments can be automated. Proceed as 
follows:

1. Stop playback and move the project cursor to the start of the project.

2. Turn off the Cycle button on the Transport bar.
This is simply a “safety measure” – if you record automation in Cycle mode, you may 
accidentally overwrite parameter changes you have made on a previous Cycle lap.

3. Click the Write (“W”) button in the a1 control panel.
This adds a plug-in automation track for the a1 in the Project window.

4. Start playback.

5. Adjust the parameters you want – create filter sweeps, add modula-
tions, etc.

6. When you’re done, click Stop.

7. Deactivate the Write (“W”) button in the A1 control panel.

8. Click the Read (“R”) button next to it.
This makes the VST Instrument “read” the recorded automation during playback.

9. Start playback from the beginning of the project.
You will now see the controls moving, replicating your recorded parameter adjustments.

That concludes the VST Instrument tutorial! If you’re satisfied with 
what you recorded, you may want to save the project by selecting 
Save from the File menu.

A new plug-in automation track is created for the VST Instrument.
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About this chapter

This chapter describes the basic procedures for editing audio in the 
Sample Editor and how to use the Process functions. For a full descrip-
tion of all settings, options and operations available, please refer to the 
chapters “The Sample Editor” and “Audio Processing and Functions” 
in the Operation Manual.

The Sample Editor

The Sample Editor allows you to edit audio, by cutting and pasting, re-
moving, drawing or processing audio data. This editing can be called 
“non-destructive”, in the sense that you can undo changes or revert to 
the original versions at any point, using the Offline Process History 
(see page 140).

What is shown in the Sample Editor?

As described on page 152, an audio event plays a section of an audio 
clip. When you open the Sample Editor for an audio event, it will display 
the waveform image of the corresponding audio clip. Above the wave-
form display is the thumbnail display, which provides an overview of the 
whole clip, with a blue rectangle corresponding to the section currently 
shown in the waveform display. You can navigate by dragging or resiz-
ing the blue rectangle in the thumbnail display.
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Editing audio in the Sample Editor – an example

This example describes how to remove a section of audio and insert it 
at another position, by using cut and paste in the Sample Editor:

1. Open the Sample Editor by double clicking an audio event in the 
Project window.

2. Select the Range Selection tool by clicking its icon on the toolbar.

3. Select a section of the clip by clicking and dragging in the waveform 
display.

Click at the position you wish to start the selection and drag...
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...to make a selection range.

4. Release the mouse when the selection is complete.
You can adjust the selection by dragging its edges.

5. Select “Cut” from the Edit menu.
The selection is removed from the clip and moved to the clipboard.

The section to the right of the selection is moved to the left to fill out the gap.
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Selecting “Paste” from the Edit menu will copy the data on the clip-
board into the clip according to the following rules:

• If there is a selection in the editor, the pasted data will replace it. 

• If there is no selection (if the selection length is “0”), the pasted data 
will be inserted starting at the grey selection line. 
The selection line can be placed at any position in the event by clicking with the 
mouse. The section to the right of the line will be moved to make room for the pasted 
material.

6. For this example, make the end of the event visible, either by using the 
scrollbar or by moving the blue rectangle in the thumbnail display, and 
click to place the selection line at the event end position.

7. Now select “Paste” from the Edit menu.
The selection that was cut from the event is inserted at the position of the selection 
line.
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Processing audio

The Process submenu on the Audio menu contains a number of audio 
processing functions. The functions can be applied to selected audio 
events or clips, or to a selected range. 

In this example, we will apply normalizing to a selected audio event. 
The Normalize function allows you to specify the desired maximum 
level of the audio. A common use for normalizing is to raise the level of 
audio that was recorded at too low an input level.

Proceed as follows:

1. Select an audio event by clicking on it with the Arrow tool in the 
Project window.

2. Pull down the Audio menu and select Process.
A submenu opens, containing all processing functions available.

3. Select “Normalize” from the submenu.
The Normalize dialog opens. 

4. For this example, use the default “Maximum” setting of 0.00 dB.

• You can use the “Preview” button to listen to the result of the process-
ing if you wish.
The processing will not be applied, just auditioned.

5. Click “Process” to apply the processing.
The audio event is normalized. 
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Applying an effect plug-in (SX only)

As described on page 104, you can add “real-time” effects in the 
Mixer. However, sometimes it is useful to apply an effect directly to an 
audio event or clip. This is done using the Plug-ins submenu on the 
Audio menu:

1. Select an audio event in the Project window.
In this example, we select the event that was normalized in the previous example.

2. Pull down the Audio menu and select Plug-ins.
A submenu appears, listing the installed effect plug-in folders. The effects are orga-
nized in these subfolders according to the effect category.

3. Select the “Flanger” effect from the Modulation subfolder.
The Flanger dialog appears.

4. Use the parameters in the upper part of the dialog to set up the effect 
as desired.
Clicking the Preview button will let you audition the settings before actually applying 
the effect.

5. Click the “Process” button to apply the effect.
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Using the Offline Process History dialog

The Offline Process History dialog allows you to remove or modify au-
dio processing at any time. It is even possible to modify or remove some 
processing “in the middle” of the Process History, while keeping later 
processing! Whether this is possible or not depends on the type of pro-
cessing performed, as described in the chapter “Audio Processing and 
Functions” in the Operation Manual.

In this example, we will remove the Normalize function, but keep the 
applied Flanger effect:

1. Select the audio event in the Project window.

2. Pull down the Audio menu and select “Offline Process History”.
The Offline Process History dialog appears. This contains a list of the processing func-
tions applied to the audio clip, with the most recent operation at the bottom of the list.

3. Select the “Normalize” action by clicking in the list.

4. Click the “Remove” button.
You are asked whether you really want to remove the processing.

5. Click “Remove”.
The Normalize processing is removed, but the Flanger effect is kept.
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About this chapter

This chapter describes the basic operations for editing MIDI in the Key 
Editor. For a full description of MIDI editing please refer to the chapter 
“The MIDI Editors” in the Operation Manual. 

This chapter assumes that you have read the instructions in the chap-
ter “Recording and playing back MIDI”, and have access to a recorded 
MIDI part.

Opening the Key Editor

By default, you open the Key Editor by double clicking a MIDI part in 
the Project window. 

The Key Editor window shows the contents of a single part. You can have several 
editors open at the same time.

• The note display is the main area in the Key Editor. It contains a grid, in which 
MIDI notes are shown as boxes. 
The width of a box corresponds to the note length, and the vertical position of a box 
corresponds to the note number (pitch), with higher notes higher up in the grid. 

• The piano keyboard to the left serves as a guide for finding the right notes. 

• The area at the bottom of the Key Editor window is the controller display, used 
for viewing and editing velocity, MIDI controllers, etc (see page 147).
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Drawing events in the Key Editor

When you move the pointer in the note display, its bar position is indi-
cated in the toolbar, and its pitch is indicated both in the toolbar and 
on the piano keyboard to the left. This makes it easy to find the right 
note and insert position.

To insert new notes in the Key Editor, proceed as follows:

1. Select the Pencil tool. 

2. Click at the desired time position and pitch (height).

A note is inserted with the following additional properties:

• If you just click once, the created note will get the length set on the 
Length Quant. pop-up menu on the toolbar.
You can create a longer note by clicking and dragging the pointer to the right with the 
mouse button pressed. The length of the created note will be a multiple of the Length 
Quantize value.

• The notes will get the Insert Velocity value set on the toolbar.
Velocity values are viewed and edited in the controller display, see page 147.
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About Snap

Snap activated on the toolbar.

The Snap function helps you find exact positions when editing in the 
Key Editor. It does this by restricting horizontal movement and posi-
tioning to certain positions. Operations affected by snap include mov-
ing, duplicating, drawing, sizing, etc.

• When the “Bars+Beats” display format is selected in the ruler, the 
Quantize value on the toolbar determines the snap value.

• When any time-based display format is selected in the ruler, editing 
snaps to the visible grid.

Selecting and moving events

To select events in the Key Editor window, proceed as follows:

1. Make sure the Arrow tool is selected.
If not, click on the Arrow icon in the toolbar.

2. To select a single event, click on it. 
To select several events, use [Shift]-clicking or click and drag a selection rectangle.

To move events in the Key Editor window, proceed as follows:

1. If you want to move more than one event, select them as described 
above.
If you want to move a single event, you don’t need to select it.

2. Click on one of the events with the Arrow tool and drag it to the de-
sired position.
If snap is activated on the toolbar, this determines the exact position of the moved 
events. 
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About quantize

Quantizing in its fundamental form is a function that automatically 
moves recorded notes, positioning them on exact note values. 

• Quantizing affects MIDI notes only (not other event types). 
• In the Project window, quantizing applies to all selected parts, affecting all 

notes within them.
• In the Key Editor, quantizing applies to all selected notes. If no notes are se-

lected, all notes will be affected.

Here follows a simple step by step example of using the quantize 
function:

1. Let’s say you have recorded a series of eighth notes, which you have 
opened for viewing in the Key Editor.
As shown in the illustration below some of them have ended up slightly beside the ex-
act eighth note positions.

Now there are two basic ways you can proceed:

• To quantize all notes in the part, no notes need to be selected.

• To quantize separate notes in the part, select them.
Only the selected notes will be quantized.

In this example, we have chosen to leave all note events in the part un-
selected.
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2. Open the Quantize pop-up menu on the toolbar.
The menu contains three main categories of note values, Straight, Triplet and Dotted.

3. For this example, select straight 1/8 Note quantize from the menu.

4. Select “Over Quantize” from the MIDI menu.
This quantizes the MIDI notes according to the Quantize pop-up menu setting.

Straight note values

Triplet note values

Dotted note values
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Editing velocity in the controller display

The Key Editor controller display is used for viewing and editing vari-
ous values and events. The controller display shows one event type at 
a time. 

• If you click the arrow to the left of the controller display, a pop-up ap-
pears allowing you to select what event type you wish to view. 
For this example, select “Velocity”.

• When “Velocity” is selected for viewing, the controller display shows 
the velocity of each note as a vertical bar.

Velocity events in the controller display.

• To change the velocity of a single note, click on its velocity bar with 
the Pencil tool, and drag the bar up or down. If there are several notes 
on the same position only the velocity value of the selected note is 
changed. If there is no note selected the velocity values for all notes 
on this position will be changed.
While you drag, the current velocity value is shown in the display to the left.

• To change the velocity values of several notes, you can either draw a 
“velocity curve” with the Pencil tool or use the Line tool to create a ve-
locity ramp.
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An example

In the following example we will create a velocity ramp using the Line 
tool:

1. Add some notes in the note display by using the Pencil tool.

2. Select the Line tool from the pop-up menu that appears by clicking on 
the Pencil tool icon.
The other tools available on this pop-up menu are described in the Operation Manual.

3. Click where you want the ramp to start, move the pointer to where you 
want the ramp to end and release the mouse button.
When the mouse button is released, the velocity values will be scaled according to the 
ramp curve.
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About this chapter

This chapter describes the basic “building blocks” and terminology in 
Cubase SX/SL. Please take your time to read this chapter thoroughly 
before moving on!

The project

The native document format of Cubase SX/SL is called a project. Be-
fore you can start recording, playing back or editing you always have 
to create a new project, or open a saved project file from disk. There 
can be several projects open at the same time, but one is always the 
active project.

Two Project windows in Cubase SX/SL. The project “on top” is the active project, 
as indicated by the lit red indicator in the upper left corner of the window.
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About the file and folder structure
A project file (file extension “.cpr” under Windows) is always associ-
ated with a project folder on your hard disk. Several projects can 
share the same project folder (which is practical if you have several 
versions of your project, for example). 

Typically, a project folder is structured like this.

• The Audio folder contains audio files referenced by the project.
It is also possible for the project to refer to audio files elsewhere on your disk(s), but 
having all audio files in the project’s Audio folder makes the project easy to move and 
archive, and is a good safety measure.

• The Edits folder contains audio files created automatically by editing 
and processing operations in Cubase SX/SL.
As a rule, you shouldn’t touch the files in this folder. To remove unused edit files, it is 
better to use the Cleanup function, as described in the Operation Manual.

• The Fades folder contains audio files created by fade and crossfade 
operations in Cubase SX/SL.

• The Images folder contains waveform images for the audio files in the 
project.

• The project file itself contains all references to audio and video files, 
along with playback information, MIDI data and settings for the project 
(such as sample rate, frame rate, etc.).

• Video files are never automatically copied to the project folder.
This is because video files are often very large, and it doesn’t make sense to copy them 
into different project folders. However, nothing stops you from creating a Video folder 
inside the project folder and storing your video files there.

• You may also find additional files in the project folder.
For example, Cubase SX/SL’s Auto Save feature stores backup copies of the project 
file in its project folder.
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Audio terminology

When you record audio in Cubase SX/SL, this is what happens:

• An audio file is created on the hard disk.
• In Cubase SX/SL, an audio clip is created. The audio clip refers to the audio 

file on disk.
• An audio event is also created in Cubase SX/SL. This plays back the audio 

clip.

There are good reasons for this long chain of references:

• The audio event is the object that you place on a time position in Cubase SX/
SL. If you make copies of an audio event and move them to different positions 
in the project, they will still all refer to the same audio clip. 
Furthermore, each audio event has an Offset value and a Length value. These 
determine at which positions in the clip the event will start and end, i.e. which 
section of the audio clip will be played back by the audio event. For example, 
if you resize the audio event, you will just change its start and/or end position 
in the audio clip – the clip itself will not be affected.

• The audio clip does not necessarily refer to just one original recorded file! 
For example, if you apply some processing to a section of an audio clip, this 
will actually create a new audio file that contains only the section in question. 
The processing will then be applied to the new audio file only, leaving the orig-
inal audio file unchanged. Finally, the audio clip is automatically adjusted, so 
that it refers both to the original file and to the new, processed file. During 
playback, the program will switch between the original file and the processed 
file at the correct positions. You will hear this as a single recording, with pro-
cessing applied to one section only.
This feature makes it possible to undo processing at a later stage, and to apply 
different processing to different audio clips that refer to the same original file.
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Audio tracks, parts and channels

For an audio event to be played back in Cubase SX/SL, it has to be 
placed on an audio track. This is similar to a track on a multi-track tape 
recorder, and allows you to view the event and move it along the time-
line. You can place any number of audio events on an audio track, but 
only one at a time can be played back. You can have a virtually unlim-
ited number of audio tracks, although the number of tracks you can 
play back at the same time depends on your computer performance.

Even though audio events can be placed directly on audio tracks, some-
times it is convenient to gather several audio events into an audio part. 
This is simply a “container”, allowing you to move and duplicate several 
audio events as one.

An event and a part.

Each audio track has a corresponding audio channel in the Mixer. This 
is much like a channel on a hardware mixer, allowing you to set levels 
and panning, add EQ and effects, etc.
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MIDI terminology

When you are recording MIDI (or entering MIDI data manually in an ed-
itor), MIDI events are created. For example, each note you record is a 
separate MIDI event, and if you record the movement of a modulation 
wheel or other controller, a large number of densely spaced events are 
created.

MIDI events are always placed in MIDI parts. These are “containers”, 
allowing you to move or copy a number of MIDI events (e.g. a recorded 
MIDI melody line) as one item.

MIDI parts are placed on MIDI tracks. For each MIDI track you can 
specify on which MIDI output and MIDI channel its MIDI events should 
be played back. This allows you to have different tracks play back dif-
ferent sounds, in the same or different MIDI instruments.

A MIDI part on a MIDI track. The black lines in the part indicate MIDI events.

Video terminology

• When you import a video file from disk into a Cubase SX/SL project, a video 
clip is created that refers to the file. 

• A video event is then created, referring to the video clip. Video events can be 
moved, copied and resized without affecting their video clips. 

• For a video event to be played back, it has to be placed on the video track. 
There can only be one video track in a Cubase SX/SL project.

The video support in Cubase SX/SL is described in its own chapter in 
the Operation Manual.
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About this chapter

This chapter contains descriptions of the general methods and proce-
dures used in Cubase SX/SL. As this information applies to all parts of 
the program and all ways of working, please take time to read this 
chapter before continuing with the Operation Manual. 

Using menus

Main menus

The menus in the main Cubase SX/SL menu bar are always available, 
regardless of which window is active. However, menu items that are 
not relevant in the current window may be greyed out. You select 
items from the main menus following the standard procedure of the 
operating system.

Pop-up menus

Pop-up menus can be found throughout the program and are often 
used for selecting options or values. A pop-up menu is indicated by a 
small arrow in a field showing the currently selected option/value. 

• To bring up the pop-up menu, click the arrow. 
Selecting is done as with regular menus.

Selecting from the Snap pop-up menu.
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The Quick menu

In Cubase SX/SL, clicking the right mouse button will bring up a con-
textual pop-up menu (under Mac OS X you need to press [Ctrl] and 
click, or preferably use a two-button mouse set up so that the right 
mouse button generates a [Ctrl]-click). 
Some areas have special context menus with functions or settings that 
only apply to the corresponding area (for example, right-clicking in a 
ruler brings up a pop-up menu with display format options). 

However, right-clicking in the main area of a window brings up the 
Quick menu. As a rule, the Quick menu contains:

• The tools (provided that the window has tools).
See page 158.

• The most relevant menu items from the main Cubase SX/SL menus.

• Settings that are specific for the window.
For example, in the Sample Editor the Quick menu contains settings for which ele-
ments should be displayed in the waveform display.

The Quick menu in the Sample Editor.
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Using tools

Editing in Cubase SX/SL is largely done with the various tools. Typical 
examples are selecting and moving events with the Arrow (Object Se-
lection) tool, drawing with the Pencil tool, deleting with the Eraser tool, 
etc. There are different tools for different windows.

Tools can be selected in three ways:

• By clicking the corresponding tool icon on the toolbar.
When you click a tool icon, the pointer takes on the shape of the corresponding tool.

• By using the Quick menu.
As described on page 157, clicking with the right mouse button in the main area of a 
window brings up the Quick menu. The tools will be listed (along with their correspond-
ing icons) at the top of the menu – to select a tool, simply select it from the menu.

• By using key commands.
By default, the keys [1] - [0] on the alphanumeric part of the keyboard are used, so that 
pressing [1] selects the leftmost tool and so on. You can also use key commands to 
step between the tools on the toolbar. By default, pressing [F9] selects the previous 
tool and pressing [F10] selects the next tool.

❐ The uses and purposes of the tools in the different windows are de-
scribed in the corresponding chapters of the Operation Manual.



CUBASE SX/SL
Basic Methods 15 – 159

About tool tips

If you position the pointer over a tool icon (or any other icon or button 
in Cubase SX/SL), a label will appear after a moment, informing you of 
the function of the icon or button. 

• This feature can be turned off by deactivating the option “Show Tips” 
on the User Interface page in the Preferences dialog (accessed from 
the File menu under Windows and from the Cubase SX/SL menu un-
der Mac OS X).

Changing values

Throughout the program you will encounter various value fields that 
can be edited. These can be divided into three categories: position 
values, regular numeric values and names.

Editing position values

Depending on the selected display format (see the Operation Manual), 
position values in Cubase SX/SL are usually divided into several “seg-
ments” (the exception being the “Samples” display format, in which 
values are edited as regular numeric values). Two examples:

If the “Seconds” display format is selected, positions are shown as 
“hours:minutes:seconds.milliseconds“.

If the “Bars+Beats” display format is selected, positions are shown as 
“bars.beats.sixteenth notes.ticks” (with 120 ticks per sixteenth note).

Each value segment can be edited separately, in one of the following 
ways:

• Point at the upper or lower edge of the segment and click.
Clicking at the upper edge will raise the value of the segment one step, clicking at the 
lower edge will lower the value.
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• Point and click directly on the value segment, type a new value and 
press [Return].

• If you are using a wheel mouse, point at the value segment and use 
the wheel to raise or lower its value.
Generally, we recommend that you use a wheel mouse, as this speeds up editing in 
many areas in Cubase SX/SL.

You can also edit the whole value (all segments) by double clicking 
and typing in a new value. Note:

• To separate the value segments, you can use spaces, dots, colons or 
any other character that isn’t a number.

• If the “Bars+Beats” display format is selected, and you enter a value 
with less than four segments, the largest position value segments will 
be affected and the program will set the lesser segments to their low-
est values.
For example, if you enter “5.3”, the position will be set to “5.3.1.0”.

• If one of the frame based display formats (all formats called “fps” or 
“dfps”) is selected, and you enter a value with less than four segments, 
the smallest position value segments will be affected and the program 
will set the larger segments to their lowest values.
For example, if you enter “2:5”, the position will be set to “0:0:2:5”.

• If the “Seconds” display format is selected, value editing works as 
with the frame based formats, with one addition: The smallest value 
segment (milliseconds) is considered to be the decimal part of the 
seconds segment.
This means that if you enter “2:50”, the position will be set to “0:0:2:500”, rather than 
“0:0:2:050”.
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Editing regular numeric values

Numeric values other than positions are edited by clicking the value 
and editing numerically from the computer keyboard.

In the Preferences dialog (User Interface – Controls page) you can 
specify what should happen when you click on a value field. The 
“Value Box/Time control” item contains the following options

• In the Inspector and elsewhere in the program you can find blue value 
sliders – click and drag to adjust the value.

Option Description

Text Input on Left-Click In this mode, clicking a value box will open it for editing by 
typing.

Increment/Decrement on 
Left/Right-Click

In this mode you can click with the left or right mouse but-
ton to decrease or increase the value, respectively. To edit 
values by typing in this mode, please double-click.

Increment/Decrement on 
Left-Click and Drag

In this mode, you can click and drag up or down to adjust 
the value (much like dragging a vertical fader). To edit val-
ues by typing in this mode, please double-click.
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• For some values, you can hold down [Alt]/[Option], click on the value 
and keep the mouse button pressed to display a value slider.
This allows you to scroll the value by dragging up or down with the mouse button 
pressed. When you release the mouse button, the value slider is hidden.

Adjusting the event volume setting on the Info line.

• These values can also be edited using a wheel mouse: point at the 
value and use the wheel to raise or lower it.

Editing names

To edit a name, click on it, type a new name and press [Return] (or 
click outside the name field).



CUBASE SX/SL
Basic Methods 15 – 163

Using knobs and sliders

In the VST audio windows, most parameters are shown as knobs, slid-
ers and buttons, emulating real-world hardware interfaces. For knobs 
and sliders, you can select the desired way of making adjustments in 
the Preferences dialog (User Interface–Controls page):

Knobs

The Knob Mode pop-up menu contains the following options:

Sliders

The Slider Mode pop-up menu contains the following options:

Option Description

Circular To move a knob, you click on it and drag in a circular motion, much 
like turning a “real” knob. When you click anywhere along the 
knob’s edge, the setting is immediately changed.

Relative Circular Works like the “Circular” option, but clicking does not automatically 
change the setting. This means you can make adjustments to the 
current setting by clicking anywhere on a knob and dragging, with-
out having to click on the exact current position.

Linear To move a knob, you click on it and drag up or down with the mouse 
button pressed – as if the knob were a vertical slider.

Option Description

Jump In this mode, clicking anywhere on a slider will make the slider handle in-
stantly move to that position.

Touch In this mode, you have to click on the actual slider handle to adjust the pa-
rameter. This reduces the risk of accidentally moving sliders.

Ramp In this mode, clicking anywhere on a slider (but not on the actual handle) 
and keeping the mouse button pressed, will cause the handle to move 
smoothly to the new position.
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Selecting objects

Selecting Cubase SX/SL objects such as audio and MIDI events is 
generally done with the Arrow tool, according to standard selection 
procedures.

• Clicking on an object selects it (and deselects any previously selected 
objects).

• Holding down [Shift] and clicking on an object selects it without dese-
lecting any other objects.

• You can also create a selection rectangle by clicking in an empty area 
and dragging with the mouse button pressed.
All objects partially or totally enclosed by the rectangle will be selected.

• If an object is already selected, you can use the left and right arrow 
key on the computer keyboard to select the previous or next object, 
respectively.
Holding down [Shift] and using the arrow keys allows you to select the previous/next 
object without deselecting the current object.

❐ There are several additional ways to make selections in the different 
Cubase SX/SL windows. These are described in the corresponding 
Operation Manual chapters.
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Zoom and view techniques

Scrolling the view

If the active window isn’t large enough to show all its contents, you can 
scroll the view by using the standard window scroll bars. However, if 
you are using a wheel mouse, there are two additional ways to scroll:

• Rolling the wheel will scroll the view vertically.
If you hold down [Shift] and use the wheel, the view will be scrolled horizontally. Just 
make sure not to point at a value field, as this will edit the value instead.

• If you aim in the main area of a window, click the wheel and keep it 
pressed, the pointer takes on the shape of a hand. You can now scroll 
the view freely by dragging the mouse horizontally and/or vertically. 

Zooming

All windows that contain graphical displays can be zoomed horizon-
tally and vertically. While some windows have special zoom functions 
(see the respective chapters in the Operation Manual), a few methods 
are commonly available:

Using the zoom sliders

At the lower right corner of all zoomable displays, you will find two 
zoom sliders.

• To zoom in horizontally, drag the horizontal zoom slider handle to the 
right.

• To zoom in vertically, drag the vertical zoom slider upwards.
There is one exception to this: in the Project window, dragging the vertical zoom slider 
upwards will decrease the height of Tracks (in effect, zooming out). See the chapter 
“The Project Window” in the Operation Manual.
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• Clicking on a zoom slider will move the handle to the click position, in-
stantly changing the magnification.

❐ If the project cursor is visible when you zoom in or out horizontally, the 
magnification will be “centered on the cursor”. In other words: if possi-
ble, the project cursor will remain in the same position on screen.

Using the Magnifying Glass tool

You can use the Magnifying Glass tool to zoom in and out horizontally, 
using the following methods:

• Click once to zoom in one step.
Zooming will be centered on the click position.

• Double click (or press [Alt]/[Option] and click) to zoom out one step.

• Draw a zoom rectangle by pressing the mouse button, dragging the 
pointer and releasing the mouse button.
The view will zoom in horizontally, so that only the area enclosed in the zoom rectangle 
is visible.

Using the Zoom submenu

At the bottom of the Edit menu, you will find a Zoom submenu with 
various zoom functions. Exactly which items on the submenu are avail-
able depends on the currently active window.

• The Zoom submenu is also available as a separate menu item on the 
Quick menu.

• As with any menu item, you can specify key commands for the func-
tions on the Zoom submenu, for quick access.
Key commands are set up in the Key Commands dialog on the File menu, described in 
a separate chapter in the Operation Manual.
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Zooming in the ruler

If the option “Zoom while Locating in Time Scale” is activated in the 
Preferences dialog (Transport page), you can use the rulers for zoom-
ing. This allows you to quickly zoom in or out on a certain position, 
without having to select a special tool:

1. Click in the ruler and keep the mouse button pressed.
The project cursor is automatically moved to the click position. If you don’t want to 
move the cursor, press [Shift] and click in the ruler instead.

2. Drag down to zoom in (horizontally) or drag up to zoom out.
Zooming will be centered on the project cursor.

Zooming in the overview

By clicking the Show Overview button on the toolbar, an extra pane 
appears under the toolbar, the project overview line. 

Show Overview button.

In the overview line, events and parts on all tracks are displayed as 
boxes. You can use the overview line to zoom in or out, and for navi-
gating to other sections of the project. This is done by moving and re-
sizing the track view rectangle in the overview line:

• The track view rectangle indicates the section of the project currently dis-
played in the event display.

• You can zoom in or out vertically by resizing the track view rectangle.
Resizing is done by dragging the edges of the rectangle.

• You can drag the track view rectangle to view other sections of the project.
The number of tracks shown will not change.
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Window handling

Generally, Cubase SX/SL windows are handled according to the 
standard procedures. However, the Window menu contains some 
functions that make work quicker and easier:

Menu item Description

Close Closes the currently active window. If this is a Project win-
dow, you will close the current project.

Close All Closes all windows, including all open projects.

Minimize All Minimizes all windows.

Restore All Restores all minimized Cubase SX/SL windows.

Tile Horizontally/Vertically 
(Windows version only)

Arranges the open windows next to each other on screen.

Cascade 
(Windows version only)

Arranges the open windows in a partially overlapping pat-
tern.

Window Layouts See page 171.

Windows... See page 169.

The open windows list Selecting a window from the list at the bottom of the menu 
brings it to front.
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The Windows dialog

By selecting “Windows…” from the Window menu, you open the 
Windows dialog. This allows you to manage the open windows in 
various ways.

The display to the left lists all open windows, hierarchically arranged 
(so that editors and other windows that belong to a certain project are 
listed under the corresponding Project window). To the right are vari-
ous window functions. To use one of the functions, proceed as follows:

1. Click in the field below the OK button to select one of the selection 
modes: 

Mode Description

Selected Only the windows selected in the list will be affected.

Cascaded The selected windows will be affected, along with all their “under-win-
dows”. Typically, if a Project window is selected in the list, all open win-
dows belonging to that project will be affected.

All All windows will be affected, regardless of the selection.
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2. If you selected the “Selected” or “Cascaded” modes, select the de-
sired windows by clicking in the list.
As usual, you can select multiple items by holding [Shift] or [Ctrl]/[Command] and 
clicking. 

3. Use the buttons to the right to activate (bring to front), minimize, re-
store or close the specified window(s).
Closing a window will also remove it from the list.

4. When you are done, click OK to close the dialog.

The Devices panel

If you like, you can manage devices from a central Devices panel:

1. Pull down the Devices menu and select “Show Panel”.
The Devices Panel appears.

2. To display a closed or hidden window, click on its button in the De-
vices panel.

3. Clicking the button again will close the window.
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Working with window layouts

A configuration of windows for the active project is called a “window 
layout”. By storing different window combinations as window layouts, 
you can quickly switch between different working modes. You may for 
example want as large as possible a Project window when you are ed-
iting, whereas you may want the Mixer and Effect windows open dur-
ing mixdown. Window layouts are listed and managed on the Window 
Layouts submenu on the Windows menu.

Editing the active window layout

There is always one layout active, even if you haven’t saved any. To 
make changes to the active window layout, proceed as follows:

• Make the desired changes to the window configuration.
This may include opening, closing, moving and sizing windows, and adjusting zoom 
and track height.

The changes are automatically stored for the active layout.

Creating a new window layout

1. Set up the windows you want to include in the window layout.
This may include opening, moving and sizing windows, and adjusting zoom and track 
height.

2. Pull down the Window menu and open the Window Layouts submenu.
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3. Select “New...”.

4. In the dialog that appears, enter a name for the window layout.

5. Click OK.
The window layout is stored and will appear on the Window Layouts submenu. It will 
now be the active layout.

Activating a window layout

1. Pull down the Window menu and open the Window Layouts submenu.

2. Select the window layout from the list on the submenu.
The windows are closed, opened, moved and/or resized according to the stored win-
dow layout.

• You can also activate any of the first nine window layouts using key 
commands.
By default, this is done by pressing [Alt]/[Option] and the corresponding key on the 
numeric keypad ([Alt]/[Option]-[1] selects Layout 1, and so on).

Recapture layout

This allows you to change or replace a stored layout: Set up the win-
dows the way you want them and select Recapture Layout. In the dia-
log that appears, enter the name of the layout you want to replace and 
click OK.
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Organizing window layouts

If you select “Organize...” from the Window Layouts submenu, a dia-
log opens, listing all available window layouts.

• To rename a window layout, double click its name in the list and type 
in a new name.

• To create a new window layout based on the current window configu-
ration, click the New button.
The new layout appears in the list allowing you to adjust its name and properties.

• To activate a layout, either select it and click the Activate button, or 
double click in the number column to the left.
The layout is activated and the dialog is closed (unless the “Keep Window Open” 
checkbox is ticked).

• To remove a window layout, select it in the list and click the Remove 
button.
The layout is removed from the list.

• To close the dialog, click the OK button.
Note that you can continue working in other windows with the Organize Layouts dialog 
open.
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Undo

There are two ways to undo operations in Cubase SX/SL: by using 
“regular Undo” and by using the Offline Process History. 

• The regular Undo can be applied to virtually all actions you perform, in 
multiple levels. 
It is accessed by using the “Undo”, “Redo” and “History” items on the Edit menu, as 
described below.

• The Offline Process History allows you to remove and modify applied 
processing, and is different from the “regular” Undo in that you don’t 
have to undo processing functions in the order they were performed. 
The Offline Process History is described in the chapter “Audio Processing and Func-
tions” in the Operation Manual.

The Undo and Redo commands

Cubase SX/SL offers wide-ranging, multiple Undo, allowing you to 
undo virtually any action you perform.

• To undo the last performed action, select Undo from the Edit menu or use the 
corresponding key command (by default [Ctrl]/[Command]-[Z]).
If you select Undo again, the previously performed action will be undone, and so on.

• To redo the last undone action, select Redo from the Edit menu or use the 
corresponding key command (by default [Ctrl]/[Command]-[Shift]-[Z]).
Undone actions will be available for Redo until you perform another action (at which 
point the “Redo stack” is cleared – see below).

❐ You can specify how many levels of Undo should be available with the 
“Maximum Undo” setting on the User Interface page in the Preferences 
dialog on the File menu (Windows) or Cubase SX/SL menu (Mac OS X).



CUBASE SX/SL
Basic Methods 15 – 175

The Edit History window

Selecting “History…” from the Edit menu opens the Edit History win-
dow. This contains a graphic representation of the “Undo stack” (the 
performed actions, with the most recent action at the top of the stack) 
and the “Redo stack” (the undone actions, with the most recently un-
done action at the bottom of the stack). The two stacks are separated 
by a divider line.

The Redo stack.

The Undo stack.

The most recently undone action.

The most recently performed action.
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The Edit History dialog allows you to undo or redo several actions in 
one go, by moving the divider between the Undo stack and the Redo 
stack (in essence, moving actions from the Undo stack to the Redo 
stack, or vice versa):

1. Click on the divider line and drag it up or down.
Drag up to redo actions, drag down to undo them.

In this case, the Delete and Split actions will be undone (and moved to the Redo 
stack).

• You can also click directly between two items in the list, instantly mov-
ing the divider line.

• When you move the divider line by dragging or clicking, the actions 
are immediately undone or redone.
The changes are reflected in all open Cubase SX/SL windows.

2. When you’re finished, click OK to close the dialog.

❐ The Undo and Redo stacks are cleared when you close a project.
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About this chapter

Most of the main menus in Cubase SX/SL have key command short-
cuts for certain items on the menus. In addition, there are numerous 
other Cubase SX/SL functions that can be performed via key com-
mands. These are all factory default settings, but can be customized if 
you like (see the chapter “Key commands” in the Operation Manual 
for details).

Below, the default key commands are listed according to category.

• As described on page 11, modifier keys are written as:
[Win modifier key]/[Mac modifier key].
For example, “[Ctrl]/[Command]+N” in the list below means “press [Ctrl] under Win-
dows or [Command] under Mac OS X, then press N”.

File commands

Devices

Commands Keys

New [Ctrl]/[Command]+N

Open [Ctrl]/[Command]+O

Close [Ctrl]/[Command]+W

Save [Ctrl]/[Command]+S

Save New Version [Ctrl]/[Command]+[Alt]/[Option]+S

Save As [Ctrl]/[Command]+[Shift]+S

Quit [Ctrl]/[Command]+Q

Commands Keys

Mixer F3

VST Outputs F4

VST Inputs F5

VST Send Effects F6

VST Master Effects F7

Video F8
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Transport commands

Commands Keys

Show/hide Transport panel F2

Start Enter

Stop Pad 0

Start/Stop Space

Record Pad *

Rewind Pad -

Fastwind Pad +

Return to Zero Pad .

Cycle on/off Pad /

Auto Punch In on/off I

Auto Punch Out on/off O

Play Selection Range [Alt]/[Option]+Space

Locate Next Event N

Locate Previous Event B

Locators to Selection P

Locate Selection L

Loop Selection [Shift]+G

Nudge Up [Ctrl]/[Command]+Pad +

Nudge Down [Ctrl]/[Command]+Pad -

To Left Locator Pad 1

To Left Locator [Shift]+1

To Right Locator Pad 2

To Right Locator [Shift]+2

To Markers 3 to 9 Pad 3 to 9

To Markers 3 to 9 [Shift]+3 to 9

Locate Next Marker [Shift]+N

Locate Previous Marker [Shift]+B
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Editing and editor commands

Set Left Locator [Ctrl]/[Command]+Pad 1

Set Left Locator [Ctrl]/[Command]+ 1

Set Right Locator [Ctrl]/[Command]+Pad 2

Set Right Locator [Ctrl]/[Command]+ 2

Set Marker 3 to 9 [Ctrl]/[Command]+Pad 3 to 9

Set Marker 3 to 9 [Ctrl]/[Command]+3 to 9

Input Position [Shift]+P

Input Left Locator [Shift]+L

Input Right Locator [Shift]+R

Insert Marker Insert

Metronome (Click) on/off C

Sync Online on/off T

Commands Keys

Undo [Ctrl]/[Command]+Z

Redo [Ctrl]/[Command]+[Shift]+Z

Cut [Ctrl]/[Command]+X

Copy [Ctrl]/[Command]+C

Paste [Ctrl]/[Command]+V

Delete Del, Backspace

Select All [Ctrl]/[Command]+A

Select None [Ctrl]/[Command]+[Shift]+A

Autoscroll on/off F

Snap On/Off J

Duplicate [Ctrl]/[Command]+D

Open [Ctrl]/[Command]+E

Repeat [Ctrl]/[Command]+K

Lock [Ctrl]/[Command]+[Shift]+L

Commands Keys
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Audio editing commands

Unlock [Ctrl]/[Command]+[Shift]+U

Cut Time [Ctrl]/[Command]+[Shift]+X

Delete Time [Shift]+Back

Paste Time [Ctrl]/[Command]+[Shift]+V

Paste at Origin [Alt]/[Option]+V

Split Range [Shift]+X

Insert Silence [Ctrl]/[Command]+[Shift]+E

Split at Cursor [Alt]/[Option]+X

Move to Cursor [Ctrl]/[Command]+L

Solo S

Mute M

Record Enable R

Quantize Q

Mute Events [Shift]+M

Unmute Events [Shift]+U

Mute/Unmute Objects [Alt]/[Option]+M

Open Score Editor [Ctrl]/[Command]+R

Open/Close Editor Return

Left selection side to Cursor E

Right selection side to Cursor D

Show/Hide Inspector [Alt]/[Option]+I

Show/Hide Infoview [Ctrl]/[Command]+I

Show/Hide Overview [Alt]/[Option]+O

Commands Keys

Crossfade X

Find selected in Pool [Ctrl]/[Command]+F

Adjust Fades to Range A

Commands Keys
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Nudge, select and navigate

Zoom commands

Commands Keys

Nudge Start Left [Ctrl]/[Command]+Left

Nudge Start Right [Ctrl]/[Command]+Right

Nudge End Left [Alt]/[Option]+Left

Nudge End Right [Alt]/[Option]+Right

Navigate/Select Left Left

Navigate/Select Right Right

Navigate/Select Up Up

Navigate/Select Down Down

Add Left [Shift]+Left

Add Right [Shift]+Right

Add Up [Shift]+Up

Add Down [Shift]+Down

Commands Keys

Zoom In H

Zoom Out G

Zoom to Selection [Alt]/[Option]+S

Zoom to Event [Shift]+E

Zoom Full [Shift]+F

Zoom in Tracks [Alt]/[Option]+Down

Zoom Out Tracks [Alt]/[Option]+Up

Zoom Out Tracks [Ctrl]/[Command]+Up

Zoom Tracks Exclusive Z

Zoom Tracks Exclusive [Ctrl]/[Command]+Down
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Tool commands

Project menu commands

Window Layout commands

Commands Keys

Previous Tool F9

Next Tool F10

Select Tool 1

Range Tool 2

Split Tool 3

Glue Tool 4

Delete Tool 5

Zoom Tool 6

Mute Tool 7

Draw Tool 8

Play Tool 9

Drumstick Tool 0

Commands Keys

Open Pool [Ctrl]/[Command]+P

Open Markers [Ctrl]/[Command]+M

Open Master Track [Ctrl]/[Command]+T

Open Browser [Ctrl]/[Command]+B

Project Setup [Shift]+S

Commands Keys

New [Ctrl]/[Command]+Pad 0

Recapture [Alt]/[Option]+Pad 0

Organize W

Layout 1 to 9 [Alt]/[Option]+Pad 1 to 9
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A
ACPI 50
Activate Project button 110
Add Track 76
All MIDI Inputs 44
Alt/Option key 11
Apple Help 10
Arrow tool 112
ASIO 2.0 40
ASIO Direct Monitoring 40
ASIO DirectX driver

About 17
Setup 38

ASIO driver
About 16
Installing 18

ASIO Multimedia driver
About 17
Setup 39

Audio Buffer Size 49
Audio Channels 153
Audio Clips 152
Audio Events 152
Audio folder 151
Audio Hardware

Connections 32
Installing (Mac) 27
Installing (Windows) 18
Requirements (Mac) 26
Requirements (Windows) 16
Setup application 35

Audio Inputs 77
Audio Parts 153
Audio Tracks 153
Automation 107

C
Channels 153
Clips

Audio 152
Video 154

Computer Requirements
Mac 25
Windows 15

Connecting
Audio 32
MIDI 41

Copy Protection key
Mac 27
Windows 18

Core Audio drivers 26
cpr files 151
Ctrl/Command key 11
Cut 136
Cycle 83

D
Default MIDI Input/Output 44
Defragmenting

Mac 28
Windows 20

Device Panel 170
DirectX driver 17
Disk Buffer settings 48

E
Edit History window 175
Edits folder 151
Effects

Adding Send Effects 
(audio) 104

Applying 139
EQ 102
Eraser tool 114
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Events
Audio 152
Copying 113
Erasing 114
MIDI 154
Moving 112
Muting 114
Resizing 116
Splitting 115

Expert Settings 49

F
Fade-in 117
Fades folder 151

G
Grid 112

H
Hard Disk

Considerations 47
Mac 25
Windows 15

Help 10
History 175
HTML Help 10

I
Images folder 151
Input Level 39, 79
Inputs 77
Installation

Mac 28
Windows 20

K
Key command conventions 11
Key Editor

Drawing Events 143
Moving Events 144
Opening 142
Selecting Events 144

Knob Mode 163

L
Latency 46
Local On/Off 42

M
Mac OS X drivers 26
Magnifying Glass Tool 166
Maximum Undo 174
Memory Requirements

Mac 25
Windows 15

Menus 156
MIDI Events 154
MIDI Input

Selecting for Tracks 87
Setting Default 44

MIDI Interface
Connecting 41
Installing (Mac) 27
Installing (Windows) 19

MIDI Parts 154
MIDI Ports

Default 44
Setting up 44

MIDI Recording 91
MIDI Thru 86
MIDI Thru Active 42
MIDI Tracks

About 154
Creating 87
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Mixer
Automating 107
Opening 99

Modifier keys 11
Monitor (MIDI tracks) 128
Monitoring 40
Multimedia driver 17
Mute 101
Mute tool 114

O
Offline Process History 140, 174
Optimizing the Hard Disk

Mac 28
Windows 20

Option/Alt key 11

P
Pan 100
Parts

Audio 153
MIDI 154

Paste 137
Plug-in automation tracks 131
Plug-ins

Applying 139
Send Effects (audio) 104

Pop-up Menus 156
Position Values 159
Process functions 138
Project

About format 150
Creating new 75

Project folder 151

Q
Quantize 145
Quick Menu 157

R
RAM

Mac 25
Windows 15

Range Selection tool 135
Recording Levels 39
Redo 115, 174
Release ASIO Driver in Back-

ground 37
Repeat 113
Ruler Zooming 167

S
Sample Editor 134
Scissors tool 115
Scroll Bars 165
Select All 113
Selecting Objects 164
Send Effects (audio) 104
Show Panels 170
Show Tips 159
Slider Mode 163
Snap 112, 144
Solo 101, 125
Start Record at Left Locator 129
Stereo/Mono switch 77
Surround Sound Setup 34

T
Tips 159
Tools 158
Tracks

Audio 153
MIDI 154
Video 154

U
Undo 115, 174
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V
Value Editing 159
Value Slider 161
Velocity 147
Video Clips 154
Video Events 154
Video Setup 45
Video Track 154
VST Inputs 77
VST Instruments

Activating 121
Automating 131
Editing 130
Playing in real time 127
Routing tracks to 123

VST Multitrack Setup 36

W
Wheel Mouse

Scrolling 165
Value Editing 160

Window Layouts 171
Window Menu 168
Windows Dialog 169
Write/Read Automation 107

Z
Zoom Menu 166
Zoom Sliders 165
Zoom while Locating 

in Time Scale 167
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